Kurzweil 3000™ for Windows
Network Installation and Administration Guide
Version 13
Component Acknowledgments:

The American Heritage® Dictionary of the English Language, Fourth Edition. Copyright © 2009 by Houghton Mifflin Company. Published by the Houghton Mifflin Company. No part of this database may be reproduced or otherwise used without prior written permission from the publisher unless such use is expressly permitted by applicable law.

Words are included in this Dictionary on the basis of their usage. Words that are known to have current trademark registration are shown with an initial capital and are also identified as trademarks. No investigation has been made of common-law trademark rights in any word. The inclusion of any word in this dictionary is not, however, an expression of the Publisher’s opinion as to whether or not it is subject to proprietary rights, nor is it to be regarded as affecting the validity of any trademark.

American Heritage® is a registered trademark of Forbes Inc. Its use is pursuant to a license agreement with Forbes Inc.

The American Heritage® Children’s Dictionary by the Editors of the American Heritage® Dictionaries. Copyright © 2005 by Houghton Mifflin Company. Published by the Houghton Mifflin Company. No part of this database may be reproduced or otherwise used without prior written permission from the publisher unless such use is expressly permitted by applicable law.

Roget’s II: The New Thesaurus, Third Edition by the Editors of the American Heritage® Dictionaries. Copyright © 2009 by Houghton Mifflin Company. Published by Houghton Mifflin Company. No part of this database may be reproduced or otherwise used without prior written permission from the publisher unless such use is expressly permitted by applicable law.

No investigation has been made of common-law trademark rights in any word. Words that are known to have current trademark registration are shown with an initial capital and are also identified as trademarks. The inclusion or exclusion of any word, or its capitalization in this dictionary is not, however, an expression of the Publisher’s opinion as to whether or not it is subject to proprietary rights, nor is it to be regarded as affecting the validity of any trademark.


ETI-Eloquence™ and RealSpeak™ © Nuance Communications, Inc. All rights reserved.

VoiceText™ is Copyright © 2005 by NeoSpeech Software, Inc.

Homophones and confusables word lists from WordSpring™ software. © 2002 Lexia Institute.

Additional product components are licensed from ABBYY™; Bennet-Tec Information Systems, Inc.; Nuance Communications, Inc.; and Vantage Technologies.

MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson.

The Picture Communication Symbols samples © 1981-2004 Mayer-Johnson, Inc., Solata Beach, CA. USA. All rights reserved worldwide.

NIMAS Sample files created by the AIM and NIMAS Centers at CAST, Inc. with support from the Office of Special Education, US Department of Education.

Portions of Kurzweil 3000 Professional Edition Copyright Design Science, Inc., 2012. All rights reserved. Unauthorized reproduction prohibited.

DESIGN SCIENCE, INC. EXPRESSLY DISCLAIMS ANY AND ALL WARRANTIES CONCERNING THIS SOFTWARE AND DOCUMENTATION, INCLUDING ANY WARRANTIES OF MERCHANTABILITY AND/OR FITNESS FOR ANY PARTICULAR PURPOSE, AND WARRANTIES OF PERFORMANCE, AND ANY WARRANTY THAT MIGHT OTHERWISE ARISE FROM COURSE OF DEALING OR USAGE OF TRADE. NO WARRANTY IS EITHER EXPRESS OR IMPLIED WITH RESPECT TO THE USE OF THE SOFTWARE OR DOCUMENTATION. Under no circumstances shall Design Science, Inc. be liable for incidental, special, indirect, direct or consequential damages or loss of profits, interruption of business, or related expenses which may arise from use of software or documentation, including but not limited to those resulting from defects in software and/or documentation, or loss or inaccuracy of data of any kind.
# Table of Contents

## Preface
About This Guide ................................................................. 2

## Chapter 1  Understanding the Kurzweil 3000 Network
Kurzweil 3000 Network Overview .............................................. 4  
About the Kurzweil 3000 Network Administrator ......................... 4  
About Kurzweil 3000 Floating Licenses ....................................... 4  
About the Kurzweil 3000 Activity Database ................................ 5  
Basic Kurzweil 3000 Network Setup ......................................... 6  
Floating Licenses and How They Work .......................................... 8  
About License-to-Go™ ............................................................ 9  
License Management Using License Keys ..................................... 9  
Important Information ............................................................ 10

## Chapter 2  Installing Kurzweil 3000 Network
The Kurzweil 3000 Network Product Package ............................. 12  
Hardware and Software Requirements ........................................ 12  
Network Engine and Administrator Requirements ........................ 12  
Client Requirements ............................................................. 13  
Installation Overview ............................................................ 14  
New Installations ...................................................................... 14  
Upgrading from Previous Network Versions ................................. 16  
Network Prerequisites ............................................................. 18  
Designating the Kurzweil 3000 Network Engine ......................... 18  
    Novell Networks .................................................................. 18  
    Ensuring TCP/IP Is Enabled .................................................. 19  
    Determining the Static IP Address of an Engine Computer 19  
Installing and Configuring the Kurzweil 3000 Network Engine... 21  
Uninstalling Previous Versions of the Engine Software ............... 21  
Installing the Kurzweil 3000 Network Engine ........................... 22
Chapter 3  Administering the Kurzweil 3000 Network

About the Kurzweil 3000 Network Administrator .................................................................47
Local Versus Remote Administration ..................................................................................47
About the Administrator Menus ..........................................................................................49
  File Menu .........................................................................................................................49
  Users Menu .....................................................................................................................49
  Tools Menu .....................................................................................................................51
  Licenses Menu ...............................................................................................................52
  Reports Menu ...............................................................................................................53
  Help Menu .....................................................................................................................53
About the Network Options Dialog Box ..............................................................................55
Administration Procedures ..................................................................................................56
Displaying Current Users ...................................................................................................57
Disconnecting Users from the Engine .................................................................................58
Locking and Unlocking the Engine .......................................................................................58
Adding Users from the Engine Computer ...........................................................................59
  Generating Multiple User Accounts from a Master File ............................................60
Adding Users from a Kurzweil 3000 Client Computer .......................................................61
Sending Messages .............................................................................................................62
Leaving Messages .............................................................................. 63
Forcing a Toolbar Set ........................................................................ 64
Broadcasting Feature Locks .............................................................. 65
Deleting Users from the Engine ...................................................... 67
  User Files and Personal Settings .................................................. 68
Using License-to-Go ........................................................................ 69
  Transferring Licenses Using the Granting Method ......................... 69
  Transferring Licenses Using Remote Code Generation ................. 72
  Generating a Remote License-to-Go Code ..................................... 73
Returning a License-to-Go License to the Engine ......................... 76
Returning a Remote License-to-Go Before It Expires..................... 77
Ensuring License Availability .......................................................... 78
  Displaying Information About License-to-Go Licenses ............... 78
License Management and License-to-Go ....................................... 79
Uninstalling Floating Licenses ......................................................... 80
Determining License Requirements ............................................... 82
Uninstalling the Kurzweil 3000 Client and Engine Software .......... 83
Uninstalling Kurzweil 3000 Client Software .................................. 83
Administering the Activity Database ............................................ 85
  Enabling Activity Logging .......................................................... 85
  What Activities Get Logged? ...................................................... 87
Updating the Database .................................................................... 88
Cleaning Up the Database .............................................................. 88
Creating Database Reports and Form Letters .............................. 89
  Generating Reports .................................................................... 89
Creating and Generating Form Letters from the Database ........... 92
  Generating a Form Letter .......................................................... 95
Kurzweil 3000 Network Engine Service ....................................... 97
Changing the Engine IP Address for Clients ................................. 98

Appendix A  Installing and Activating a Kurzweil 3000 Remote Client

Installation and Activation Overview ............................................. 100
Installing the Kurzweil 3000 Client Software ................................ 101
Determining the System Code of Your Computer ....................... 102
Activating the Kurzweil 3000 Client Software ............................... 103
Returning a Remote License-to-Go Before It Expires.................... 104
Appendix B  Setting Up Read the Web
Selecting Internet Explorer as the Default Browser ...............106
Selecting Firefox as the Default Browser...........................107
Installing the Firefox Browser.........................................107
Installing or Updating the KESIReader Firefox Extension ....109
Uninstalling the KESIReader Firefox Extension.....................110
Updating the Firefox Extension.......................................111

Appendix C  Setting Up the Kurzweil 3000 Taskbar
Showing or Hiding the Kurzweil 3000 Taskbar .................112
Using the Kurzweil 3000 Taskbar....................................113

Appendix D  Setting Up the Universal Library
Creating the Universal Library Folder.............................114
Configuring Access to a Universal Library Folder...............115
Using the Universal Library..........................................116

Index ..................................................................................117
Preface

Welcome to Kurzweil 3000 networking. A Kurzweil 3000 Network provides all of the features and benefits of the single-user Kurzweil 3000 product, but with the following added advantages:

- The Kurzweil 3000 Network Engine (Engine) stores each student’s Kurzweil 3000 settings, preferences and activity. This allows students to access customized settings from any Kurzweil 3000 Client computer (Client) connected to the Kurzweil 3000 Network (Network).

- System Administrators and/or teachers can manage large and changing numbers of Kurzweil 3000 users and Kurzweil 3000 licenses using the Kurzweil 3000 Network Administrator.

- Using the License-to-Go™ feature, System Administrators and/or teachers can transfer licenses to Network users, allowing them to use Kurzweil 3000 even when they are not connected to the Network.

- Using the Remote License-to-Go feature, System Administrators and/or teachers can transfer licenses to users without requiring them to connect to the Network to perform the transfer.

- Using the Kurzweil 3000 Network Administrators Broadcast Feature Locks option, System Administrators and/or teachers can lock selected Kurzweil 3000 features on multiple Client computers.

- Teachers can track each student’s progress and daily interaction with Kurzweil 3000 with easy-to-use reporting features.

- Teachers can provide timely student activity information to parents and other interested parties using the Generate Form Letters feature.
About This Guide

This guide provides information for installing and administering a Kurzweil 3000 Network. However, it assumes a knowledge of networking typically possessed by System Administrators.

Besides this Preface, this guide contains the following chapters:

• Chapter 1, Understanding the Kurzweil 3000 Network, provides an overview of how the Kurzweil 3000 Network works and its benefits.

• Chapter 2, Installing Kurzweil 3000 Network, provides instructions on setting up a Kurzweil 3000 Network.

• Chapter 3, Administering the Kurzweil 3000 Network, provides instructions on Network administration tasks, including adding and deleting user accounts, managing floating licenses, granting licenses, using the Activity database to generate reports and letters and administering the Kurzweil 3000 Engine service.

• Appendix A: Installing and Activating a Kurzweil 3000 Remote Client, provides instructions that you can copy and distribute to students, teachers or trainers who need to install and activate Kurzweil 3000 using the Remote License-to-Go feature.

• Appendix B: Setting Up Read the Web, provides information for setting up the Read the Web default Web browser.

• Appendix C: Setting Up the Kurzweil 3000 Taskbar, provides a brief overview of the Kurzweil 3000 Taskbar application.

• Appendix D: Setting Up the Universal Library, provides instructions for setting up file sharing through the Universal Library.
1 Understanding the Kurzweil 3000 Network

The information in this chapter is arranged into the following main topics:

- *Kurzweil 3000 Network Overview* on page 4.
- *Basic Kurzweil 3000 Network Setup* on page 6.
- *Floating Licenses and How They Work* on page 8.
Kurzweil 3000 Network Overview

The Kurzweil 3000 local area network consists of one or more (usually many more) computers running Kurzweil 3000 Client software and a smaller number of computers running the Kurzweil 3000 Network Engine software. The Client computers access the computer(s) running the Network Engine software over a TCP/IP network. For details, see Basic Kurzweil 3000 Network Setup on page 6.

About the Kurzweil 3000 Network Administrator

The Kurzweil 3000 Network Administrator (Administrator) program allows you to control many Kurzweil 3000 Network tasks. It makes it easy to add and remove users, to provide different levels of access and functionality to individual users or groups of users and to track and report on various aspects of the Network Engine’s activity and usage.

You can install and use the Administrator on any supported computer, regardless of whether that computer also has a Kurzweil 3000 Network Engine installed on it. This makes it easy for teachers to manage users and licenses and to use other Network features right from their desks, while allowing the Network Engine to be installed on a computer in a secure area with other network resources.

For details, see About the Kurzweil 3000 Network Administrator on page 47.

About Kurzweil 3000 Floating Licenses

A Kurzweil 3000 Network uses a system of floating licenses to support large numbers of users. You can install and uninstall licenses as needed using the Administrator.

You can also transfer licenses to Network users using the License-to-Go feature. A transferred license allows users to use Kurzweil 3000 even if they are not connected to the Network. For details, see About License-to-Go™ on page 9.
About the Kurzweil 3000 Activity Database

The Kurzweil 3000 Network includes a database that you can use to produce reports on student interaction with Kurzweil 3000. You can monitor such activities as definition, synonym, and syllable lookups, changes to reading speed, and spell check errors. You can also incorporate this data into form letters similar to a mail merge, allowing you, for example, to create weekly student progress letters that can be sent home to parents. For details, see *Administering the Activity Database* on page 85.
Basic Kurzweil 3000 Network Setup

A typical Kurzweil 3000 Network setup is constructed as follows:

- One or more computers on the local area network (LAN) running the Kurzweil 3000 Network Engine software.
  
  **Note:** A Kurzweil 3000 Network Engine can be installed on *any* computer on the LAN as long as it has a static IP address and is running Kurzweil 3000-supported Windows operating system.

- One or more computers on the LAN running the Kurzweil 3000 Network Administrator. Teachers and/or System Administrators use the Administrator to manage the Kurzweil 3000 Network.
  
  **Note:** In order to generate reports or form letters, you must run a copy of the Administrator that is installed on the same computer as the Kurzweil 3000 Network Engine.

- Multiple LAN-connected computers, called *Client* computers, each of which has a copy of Kurzweil 3000 installed on it. Each Client computer runs Kurzweil 3000 software.
Chapter 1. Understanding the Kurzweil 3000 Network

Kurzweil 3000 Network diagram

Using an Administrator in remote mode, teachers can perform all administration tasks except for report and form letter generation. See Local Versus Remote Administration on page 47.

Using the Administrator installed (by default) on a Kurzweil 3000 Engine computer, in local mode, teachers or System Administrators can perform all administration tasks, including report and form letter generation. See Local Versus Remote Administration on page 47.

User preferences and settings for users A, B, C and D are stored on the Kurzweil 3000 Engine computer in personal folders. See User Files and Personal Settings on page 68.

Students can use Kurzweil 3000 at home with Kurzweil 3000 Granted or Remote License-to-Go licenses. See About License-to-Go™ on page 9.

When students want to use Kurzweil 3000, they log on to the Kurzweil 3000 Network from any computer on which the Client software is installed.

While on the Kurzweil 3000 Network, they can work with their personal documents using their preferred Kurzweil 3000 settings, which are saved on a Kurzweil 3000 Network Engine.
Floating Licenses and How They Work

Kurzweil 3000 Network uses floating licenses to help you support multiple users—from five to 500 or more—across a LAN.

The Benefits of Floating Licenses

Kurzweil 3000 floating licenses are licenses that are associated with users, not machines. The main benefits of floating licenses are:

• Multiple users can access Kurzweil 3000 simultaneously, as long as there are enough licenses.

• Teachers and System Administrators can manage software licenses using the Administrator.

• Users can access Kurzweil 3000 from any computer on the Kurzweil 3000 Network while maintaining their personal user settings.

Floating Licenses and the Kurzweil 3000 Network Engine

Think of floating licenses as passes that let users access Kurzweil 3000 software over a network. When users log on to Kurzweil 3000 Client computers, they are essentially borrowing licenses to use the software.

The Kurzweil 3000 Network Engine:

• Acts as an electronic librarian, tracking all the floating licenses that are in use.

• Maintains information about what Kurzweil 3000 products are on the Network.

• Provides users with appropriate access to those products and manages the use of the licenses.
About License-to-Go™

The Kurzweil 3000 License-to-Go feature allows students to use Kurzweil 3000 Client software without having to be connected to the Network.

You can provide a License-to-Go using the following methods:

**Granting a License-to-Go.** Use this method to transfer a license from the Kurzweil 3000 Engine to a Kurzweil 3000 Client computer connected to the Kurzweil 3000 Network. After you grant the license, the Client can then be disconnected from the Network and used outside of the Network.

This method is useful for students with laptops who need to use Kurzweil 3000 both in school and at home. It also allows students to use Kurzweil 3000 in areas of the school that do not have access to the Kurzweil 3000 Network.

**Generating a Remote License-to-Go Code.** Use this method to create a Remote License-to-Go Code, which a student can use to activate Kurzweil 3000 Client software installed on a computer that is not connected to a Kurzweil 3000 Network.

This method is useful for students, teachers or trainers who need to use Kurzweil 3000 on a home computer that cannot be transported to school.

Both granted and generated licenses are valid for a specified period of time. When the time expires, the license automatically becomes available again on the Engine, and unavailable to the user to whom the license was transferred. For details, see *Using License-to-Go* on page 69.

License Management Using License Keys

When your organization purchases a Kurzweil 3000 product, the floating licenses for the product come on one or more License Keys included with the product package. License Keys are on USB “thumb” drives.

You install the desired number of floating licenses onto the Kurzweil 3000 Network Engine (this can be a good way to “ration” the licenses) and uninstall or “return” them back to the License Key until you need them again. See *Determining License Requirements* on page 82.
Important Information

Do Not Move or Copy Files in the Engine Folder

The Kurzweil 3000 Engine folder, located in the Kurzweil 3000 Application Data folder on your hard drive, contains files that are critical to the tracking of your Kurzweil 3000 floating licenses. Any attempt to modify, move or copy the files in this folder may invalidate your valuable licenses.

Do Not Alter the System Clock and Calendar

Also, as license granting is date and time dependent, it is imperative that you do not alter the clock and calendar settings on the Engine. Furthermore, you should warn users to whom you have granted licenses that they should not change these settings on the machine to which the license has been granted.
2 Installing Kurzweil 3000 Network

The chapter includes the following main topics:

• *The Kurzweil 3000 Network Product Package* on page 12.
• *Hardware and Software Requirements* on page 12.
• *Installation Overview* on page 14.
• *Network Prerequisites* on page 18.
• *Installing and Configuring the Kurzweil 3000 Network Engine* on page 21.
• *Setting User Logon and Client Options* on page 25.
• *Installing Floating Licenses* on page 29.
• *Installing and Configuring the Client Software* on page 32.
• *Installing Remote Copies of the Administrator* on page 44.
• *What’s Next?* on page 45.
The Kurzweil 3000 Network Product Package

The Kurzweil 3000 Network Edition product package includes:

- A product DVD with installation files for the following:
  - Kurzweil 3000 Network Engine program
  - Network Administrator (local and remote) software
  - Client (local and remote) software

  **Note:** Client software installation includes NeoSpeech VoiceText™ English-speaking and Spanish-speaking voices.

  **Note:** Microsoft Speech Runtime 11 Voices is available for installation in MicrosoftSpeech folder (see page 34). (Note: A setup program is provided by Microsoft which handles the installation. These voices are not supported by Windows XP, but can be used with Windows Vista, Windows 7, and Windows 8.)

- License Key(s) (USB drive(s)) containing the licenses for the Kurzweil 3000 product(s) your organization purchased.

- Serial Number.

Hardware and Software Requirements

This section details the minimum hardware and software requirements for the Kurzweil 3000 Network Engine, Kurzweil 3000 Network Administrator and Kurzweil 3000 Client software.

Network Engine and Administrator Requirements

- Processor: 450 MHz Pentium 3 or better
- System Memory: 256 MB
- Hard Disk Space: 50 MB free space for the Kurzweil 3000 Network software only
Chapter 2. Installing Kurzweil 3000 Network


DVD drive
USB 2.0 port
Keyboard and mouse
Microsoft Windows-compatible LAN with TCP/IP protocol
Static IP address

Client Requirements

Processor: 1.3 GHz Pentium 4 or better
System Memory: 512 MB (1GB for 64-bit Windows Vista, Windows 7, or Windows 8)
Hard Disk Space: 2 GB free space
Operating System: Microsoft® XP with Service Pack 3 or later, Windows Vista with Service Pack 1 or later, Windows 7, Windows 8
Screen Resolution: 1024x768 24-bit or better
Color Palette: 16-bit
DVD drive
Keyboard and mouse
Scanner (TWAIN-compatible)
Sound card with speakers and microphone
Internet connection for registration and certain features (Google Translate, Online Book Search, Read the Web)
Web browser: Mozilla Firefox 3.5 or later or Microsoft Internet Explorer 7 or later
For Audio File Creation: MP3 encoder and/or media player
Installation Overview

As you prepare to install Kurzweil 3000 Network, you will either be upgrading from a previous version of Kurzweil 3000 Network or installing it for the first time (this includes upgrading from Kurzweil 3000 Standalone).

If you are installing a Kurzweil 3000 Network for the first time, go to the next section, New Installations.

If you are upgrading from a previous version of Kurzweil 3000 Network, go to Upgrading from Previous Network Versions on page 16. You might want to review Designating the Kurzweil 3000 Network Engine on page 18 if you plan on installing the Engine software on new computers.

New Installations

Use the following general steps as a guide for setting up a new Kurzweil 3000 Network. Steps should be performed in the following sequence:

General Network:

Make sure that all the Kurzweil 3000 Engine and Client computers that will be part of the Kurzweil 3000 Network have TCP/IP enabled. See Network Prerequisites on page 18.

For Kurzweil 3000 Engine computers:

1. Make sure that all the computers that you choose to be Kurzweil 3000 Network Engines are accessible over the network, that they are running a Kurzweil 3000-supported operating system, and that they are set up with static IP addresses. For more information, see Network Prerequisites on page 18.

2. Install and configure the Network Engine software and floating licenses on computers that are designated to be the Kurzweil 3000 Network Engines. For more information, see Installing and Configuring the Kurzweil 3000 Network Engine on page 21.

3. Optionally, install the Universal Library. See Installing the Kurzweil 3000 LAN Universal Library on page 41.
Chapter 2. Installing Kurzweil 3000 Network

For Kurzweil 3000 Network Client computers:

1. If necessary, uninstall previous versions of VoiceText speaking voices. See Uninstalling Previous Versions of VoiceText on page 34.

2. Optionally, uninstall previous versions of Kurzweil 3000 (Standalone) from computers on which you will install Kurzweil 3000 Client software. See Uninstalling Previous Versions of Kurzweil 3000 on page 32.

3. Install the Client software on each computer that you want to run Kurzweil 3000. For more information, see Installing and Configuring the Client Software on page 32.


5. Review the Additional Client Configuration Procedures on page 40, and perform as necessary.

6. Optionally, enable Clients to access the Universal Library folder on the Engine computer. See Configuring Access to a Universal Library Folder on page 42.

7. Optionally, install additional instances of the Administrator. See Installing Remote Copies of the Administrator on page 44.

   Additional Administrators should be installed for use by teachers, who can then manage licenses and use other Network features.

Notes:

- When the Administrator is run on a computer that does not also have the Kurzweil 3000 Engine software installed, you cannot use the Reporting and Form Letter features. These functions can only be initiated from a Kurzweil 3000 Engine computer. See Local Versus Remote Administration on page 47.

- The Administrator does not have to be installed on a computer that also has the Kurzweil 3000 Client software installed. You can install it on any computer that is on the same LAN as the Kurzweil 3000 Engine.
Upgrading from Previous Network Versions

Use the following general steps as a guide for upgrading from a previous version of Kurzweil 3000 Network.

The upgrade steps should be performed in the following sequence:

For Kurzweil 3000 Engine computers:

1. Uninstall floating licenses back to the appropriate License Key. See Uninstalling Floating Licenses on page 80.

2. Uninstall the previous version of the Kurzweil 3000 Engine. See Uninstalling the Kurzweil 3000 Client and Engine Software on page 83.

3. For Engines installed on computers running Windows XP with Service Pack 2, you must specify an exception for the port that the Engine uses to connect to its Clients. See Installing and Configuring the Client Software on page 32.

   Note: If you specified the exception for the previous version of the Engine, you do not have to do it again.

4. Install the Engine software and floating licenses onto computers on the LAN that are designated as Kurzweil 3000 Network Engines. See Installing and Configuring the Kurzweil 3000 Network Engine on page 21.

For Kurzweil 3000 Client computers:

1. If necessary, uninstall previous versions of VoiceText speaking voices. See Uninstalling Previous Versions of VoiceText on page 34.

2. Optionally, uninstall previous versions of Kurzweil 3000 (Network Client and/or Standalone). See Uninstalling Previous Versions of Kurzweil 3000 on page 32.

3. Install the Client software on each computer that you want to run Kurzweil 3000. For more information, see Installing Kurzweil 3000 on Client Computers on page 35.

5. Review the *Additional Client Configuration Procedures* on page 40, and perform as necessary.

6. Optionally, install additional copies of the Kurzweil 3000 Administrator. See *Installing Remote Copies of the Administrator* on page 44.

Additional Administrators should be installed for use by teachers, who can then manage licenses and use other Network features (Send and Leave Messages, Force Toolbars, etc.).

**Notes:**

- When the Administrator is run on a computer that does not also have a Kurzweil 3000 Engine installed, you cannot use the **Reporting** and **Form Letter** features. These functions can be initiated only from a computer running a Kurzweil 3000 Engine computer. See *Local Versus Remote Administration* on page 47.

- The Administrator does not have to be installed on a computer that also has the Kurzweil 3000 Client software installed. You can install it on any computer that is on the same LAN as the Kurzweil 3000 Engine.
Network Prerequisites

This section provides important information and assistance for persons who are responsible for installing a Kurzweil 3000 Network. If you have previously installed a Kurzweil 3000 Network, you might want to skip this section and go to Installing and Configuring the Kurzweil 3000 Network Engine on page 21.

Designating the Kurzweil 3000 Network Engine

Any computer running a supported Windows operating system on the LAN can be a Kurzweil 3000 Network Engine; you just have to install the Kurzweil 3000 Network Engine software on it, and keep it up and running and connected to the LAN.

It is important that both the computer on which you install the Engine and the Kurzweil 3000 Engine service itself are up and running most of the time. This is especially important if you use the license granting feature, as the ability for the Engine to regenerate expired licenses is directly affected by the amount of time an Engine is continuously running.

You must install Kurzweil 3000 Engines on computers running Kurzweil 3000-supported Windows operating systems to have system stability and remote administration capabilities.

Although it is possible to install the Engine software on the same computer as the Client software, we don't recommend that you do it.

In addition, you can have multiple Kurzweil 3000 Network Engine computers, each one serving different clusters of Kurzweil 3000 Client computers.

**Novell Networks**

Kurzweil 3000 can be used over Novell networks (version 4.x or later), but the Engine software must be installed on a computer running Kurzweil 3000-supported Windows operating systems. The software cannot be installed on the Novell server computer.
Ensuring TCP/IP Is Enabled

In setting up any network, you have to ensure that the Engine and Client computers can share resources, communicate with one another. TCP/IP is a set of industry-standard protocols that facilitates network tasks and requests such as file transfers, and remote computing.

To determine if TCP/IP is enabled:

**On Windows XP or Windows 2003:**
1. From the Windows Start menu, select Control Panel, then click Network and Internet Connections.
2. Double-click Network Connections.
3. Double-click Local Area Connection, then open its Properties dialog.
4. Make sure that TCP/IP is on the list, and that it is selected.
5. Close the dialog box.

**On Windows Vista, Windows 7, or Windows 8:**
1. From the Control Panel, go to Network and Internet, and then Network and Sharing Center.
2. Find View Network Status for your Local Area Connection.
3. In the Local Area Connection Properties dialog, ensure that the desired Internet Protocol is selected.

**On Windows 2008:**
Find Internet Protocol Properties for the network area connection you want, and ensure that the desired Internet Protocol is selected.

Determining the Static IP Address of an Engine Computer

Networks require addresses for each computer to properly route information, commands and requests to the correct recipient.

TCP/IP assigns an IP address—a unique number string—to every computer that is configured for network use. There are two types of IP addresses that can be assigned to your computer: static or dynamic. The Kurzweil 3000 Network Engine must be set up with a static IP address.
Depending on the Engine computer's operating system, use one of the following procedures to determine the computer’s static IP address.

**To determine the static IP address:**

**On Windows XP or Windows 2003:**

1. On the designated Kurzweil 3000 Network Engine computer, select **Control Panel** from the Windows **Start** menu.
2. Double-click **Network Connections**.
3. Right-click **Local Area Network** and select **Properties** from the menu.
4. Select **TCP/IP** in the list and click the **Properties** button.
5. Select **Use the following IP address**. If the area is active, write down the number—this is the static IP address you need during the Client installation.

   If the **Use the IP address** area is not active, you must request a static IP address from your IT manager.

**On Windows Vista, Windows 7, or Windows 8:**

1. From the Control Panel, go to Network and Internet, and then Network and Sharing Center.
2. Find **View Network Status** for your **Local Area Connection**.
3. In the Local Area Connection **Properties** dialog, find **Details**.
4. Write down the number—this is the static IP address you need during the Client installation.

   If the IP address is not active, you must request a static IP address from your IT manager.

**On Windows 2008:**

Find Internet Protocol Properties for the network area connection you want, note the IP address.
Installing and Configuring the Kurzweil 3000 Network Engine

The recommended installation and configuration steps are as follows:

- If necessary, uninstall previous versions of the Kurzweil 3000 Network Engine software.
- Install the Kurzweil 3000 Network Engine software.
- Set **User Logon** and **Client** options.
- Install licenses.
- Configure the Windows firewall if you installed the Engine on a computer running Windows XP with Service Pack 2.
- Install the Universal Library (optional).

Uninstalling Previous Versions of the Engine Software

You must uninstall previous versions of the Kurzweil 3000 Network Engine software before installing a new version.

*Note*: Previous to Version 10, the Kurzweil 3000 Network Engine was called the Kurzweil 3000 Server (Server).

To uninstall the Engine software:

1. From the Windows **Start** menu, go to Control Panel>Add/Remove Programs.
2. Select **Kurzweil 3000** from the list of programs.
3. Click **Remove**.
4. In the message box that appears, click **Yes** to confirm that you want to uninstall the software.

The uninstall process begins.

If there are any licenses installed, a message appears warning you to either quit the uninstall program and uninstall the licenses back to the License Key, or proceed with the knowledge that you will lose the licenses.
5. Click **OK** to exit from the uninstall program so that you can uninstall the licenses, or click **Destroy Licenses** to continue the uninstall process. When the process is complete, a message appears prompting you to restart Windows.


**Notes:**

For uninstalling on Vista, Windows 7, or Windows 8:
- From the Control Panel, use **Programs Uninstall**.
- Monitor the uninstall process; when you see the **User Account Control** dialog, click **Allow** to allow the program to be uninstalled.

For uninstalling Kurzweil 3000 Network software:
- If, for some reason, you need to uninstall the Kurzweil 3000 Network software, see *Uninstalling the Kurzweil 3000 Client and Engine Software* on page 83.

**Installing the Kurzweil 3000 Network Engine**

You can install the Engine software after you have ensured that your designated Kurzweil 3000 Network Engine computer has:
- TCP/IP enabled.
- A static IP address.

If you are not certain of these prerequisites, review *Network Prerequisites* on page 18.

**Note:** You can install additional copies of the Administrator on other computers using the **Install Remote Administrator** option. See *Installing Remote Copies of the Administrator* on page 44.
To install the Engine software:

1. Log in as Administrator.
2. Place the Kurzweil 3000 DVD in the DVD drive.
4. In the Master Installation dialog, select Network Software.
5. In the Network Software window, select Install Engine and Administrator.
6. Follow the prompts until the installation process is Finished.

The installation process installs the Engine software and a copy of the Kurzweil 3000 Network Engine Administrator.

You should now see the Kurzweil 3000 Network Administrator shortcut icon on the desktop.

7. Remove the Kurzweil 3000 DVD.
9. Enter the TCPIP address by doing the following:
   - Double-click the Kurzweil 3000 Network Administrator icon.
   - Enter the IP address. See Network Prerequisites on page 18.
   - Restart Windows.
10. If your network firewall is “On,” set Kurzweil 3000 as an exception. See Configuring the Firewall on page 24.


Note: Keep the Kurzweil 3000 Network Engine computer turned on and connected to the LAN at all times. The Kurzweil 3000 Network Engine computer must be running for Client users to be able to access and work with the software. Also, failure to keep the Engine running may result in the temporary loss of granted licenses.

Configuring the Firewall

By default, computers running Windows Server 2003 and 2008, Windows XP with Service Pack 2 (SP2) and Windows Vista have a software firewall enabled. This firewall blocks the port that the Engine uses to connect to its Clients. In order to restore the connection, you must specify a port exception for the firewall.

Notes:

• If you disable the firewall, you do not need to specify the port exception.

• You only need to perform this procedure on computers running the Network Engine. You do not need to do it on Kurzweil 3000 Client computers or on computers running a Remote Administrator.

On Windows XP or Windows 2003:

1. From the Windows Start Control Panel, select Windows Firewall, then click Allow a Program through Firewall.

2. The Windows Firewall Settings dialog opens to the Exceptions tab.

   In the Name field, type Kurzweil 3000 Network Engine.

   In the Port field, type 1006.

   For the Protocol, select TCP.

3. Click OK, and close the Control Panel.
On Windows Vista, Windows 7, Windows 8, or Windows 2008:

1. From the Windows Start Control Panel, select Windows Firewall, then click Allow a Program through Firewall.

2. Change Settings to Allow Another Program.

3. Add Program using Browse. On your hard drive, find Program Files/KESI.

4. Select Kurzweil 3000 Network Administrator.

5. Click Add.

6. Click OK, and close the Control Panel.

Setting User Logon and Client Options

After you have successfully installed the Engine, you should set the Engine options that control how Kurzweil 3000 creates user accounts and how users log on to the Network.

Although it is not required that you set these options now, doing so can simplify your ongoing Network administration tasks. You can change the options at any time if necessary.

To specify the user logon and Client options:

1. Double-click the Kurzweil 3000 Network Administrator desktop shortcut icon.
The **Kurzweil 3000 Network Administrator** window opens.

2. From the **Tools** menu, choose **Options** to open the **Network Options** dialog.

3. Set the **User Logon** options.
   
   The options in the **User Logon** area of the **Network Options** dialog determine how users specify their user name when they log on to the Kurzweil 3000 Network.
Chapter 2. Installing Kurzweil 3000 Network

Choose among the following options for your site:

- **Ask for Kurzweil 3000 User Name** (the default) to direct Kurzweil 3000 to prompt users for a user name when they start Kurzweil 3000 on a Client computer.

  If a user is not currently on the **User Name** list displayed in the Log On dialog box, he or she enters a new name, and the Engine creates a new account (if the **Allow Clients to Create New Accounts** option is enabled) using that name.

  This option is recommended in situations where individual users do not have unique Windows accounts but instead use same Windows logon name/account, for example Mrs. Heath’s Classroom. With this option enabled, the Engine creates individual user folders inside a folder named Mrs. Heath’s Classroom. Otherwise, if the **Use Windows Logon Name** option was selected, all student files would be saved inside a single folder named Mrs. Heath’s Classroom.

- **Use Windows Logon Name** to direct the Engine to automatically log users on using their Windows user names.

  With this option enabled, if a new user tries to log on to the Kurzweil 3000 Network, the Engine automatically creates a new user account (if the **Allow Clients to Create New Accounts** option is enabled) using the Windows logon name. This selection is recommended in situations where each user has a unique Windows account.

- **Show User Name List to Clients**. You have the choice of displaying a **User Name** list on Clients (the default) or hiding it.

  The **User Name** list is a menu Kurzweil 3000 displays on a Client during login. The list contains the user names of all accounts currently
recognized by the Engine. A current user needs only to choose his or her name from the list to log on to the Network and use Kurzweil 3000.

If you choose to hide the list, users must type their user names into the Log On dialog box each time they want to access Kurzweil 3000.

Hiding the list provides slightly better security in that users can keep their user names secret, and they can’t easily log on under another account by simply choosing a name from the User Name list.

This option only applies if you are using the Ask for Kurzweil 3000 User Name option. See Step 3 on page 26.

4. Set the Client Options.

Choose Allow Clients to Create New Accounts enables new user accounts to be created from any Kurzweil 3000 Client computer. This option is enabled by default. See the Notes section for information on the consequences of enabling or disabling this option.

See Enabling Activity Logging on page 85 for more information about the Log User Statistics option and its use with the Activity database.

See Broadcasting Feature Locks on page 65 for more information on locking Kurzweil 3000 Client features from the Administrator.

Notes:

- For either of the User Logon options, you can disable automatic/manual account creation by deselecting Allow Clients to Create New Accounts. This may be preferable in situations where there are a limited number of licenses available. In this case you would create accounts using the Administrator’s Add User function. See Adding Users from the Engine Computer on page 59.

- If you deselect Allow Clients to Create New Accounts and you choose Use Windows Logon Name in the User Logon area, you must create accounts with the Administrator using each user's Windows account user name. See Adding Users from the Engine Computer on page 59 or Adding Users from a Kurzweil 3000 Client Computer on page 61.
• If you have a large number of users, you can bulk load a user name file to the Engine. See *Generating Multiple User Accounts from a Master File* on page 60.

**Installing Floating Licenses**

Ensure that you have the USB license key before installing floating licenses.

**To install a floating license:**

1. Double-click the *Kurzweil 3000 Network Administrator* desktop shortcut icon.

   The *Network Administrator* appears.

   <Kurzweil 3000 Administrator> is on the list because you are logged on as the Administrator. The *Status Bar* shows that there are no licenses installed.

2. From the **Licenses** menu, choose **License Management**.

   The *License Management* window appears.
3. Insert the **License Key** USB device and click **Read Key**.

   The **License Management** window displays the product name, the number of licenses this key can store (**Key Max**) and the number of licenses currently stored (**On Key**).

4. Click **Install**.

   The **Install License(s) on System** dialog box appears.

5. Type the number of licenses you want to install; click **OK**.

6. In the next window, verify the number of licenses to install, then click **Yes**.

7. A message appears indicating that the license installation is complete; click **OK**.

8. The **License Management** window now displays the number of installed licenses and the number of licenses left on the key.

9. Click **Done** to close the **License Management** window.
10. Safely remove the **License Key** USB device.

Users can access Kurzweil 3000 as long as there are available floating licenses. If all the licenses are in use, new users trying to access the software will not be able to do so; Kurzweil 3000 prompts them to try again later.

**Notes:**

- Your License Keys contain the number of licenses you purchased for a particular Kurzweil 3000 product. Subsequent product licenses you purchase come with their own License Key.

- Do not reformat Kurzweil 3000 Network License Keys. Keep License Keys in a safe place as they are an important part of managing and controlling floating licenses. You’ll need them for uninstalling and adding floating licenses as the user community requirements dictate.
Installing and Configuring the Client Software

You must install and configure the Client software on each computer that will connect to a Kurzweil 3000 Network Engine.

Before installing the Client software, you might need to uninstall the following:

- Previous versions of Kurzweil 3000 Client or Standalone software.
- Previous versions of VoiceText speaking voices.

You might also need to perform one or more of the following configurations:

- If you installed the Universal Library, you must configure each Client to access it. See Configuring Access to a Universal Library Folder on page 42.
- You might also need to specify a port exception for Read the Web access. See Configuring Clients for Read the Web Access on page 40.

Uninstalling Previous Versions of Kurzweil 3000

After you have completed installing and configuring the Engine software, you can begin setting up the Client software. The first step is to decide whether you want to uninstall previous versions of Kurzweil 3000 software.

If you have Version 10 or earlier of either Kurzweil 3000 Client or Standalone on any computer that is or will be a Client computer, we recommend that you uninstall it before installing the current version, although it’s not necessary to uninstall it. In fact, if you have Version 8, or earlier you should not uninstall in the following situations:

- If you want to use RealSpeak English (voices Jennifer and Jane).
- If you want to use RTK (Expervison OCR engine).

Both of the above Kurzweil 3000 components are not included with Kurzweil 3000.

If you are uninstalling a Kurzweil 3000 Standalone, you should have available the Kurzweil 3000 product key disk that you are going to uninstall.
Note: Uninstalling older versions of Kurzweil 3000 does not affect user settings or any existing Kurzweil 3000 user files or documents.

To uninstall older versions of Kurzweil 3000:

1. Login as Administrator.

2. From Windows Start menu, go to Control Panel Add/Remove Programs.

3. Find, select and Remove Kurzweil 3000.
   
   If you are uninstalling a Kurzweil 3000 Standalone version, a message displays asking if you want to save your license in case you want to re-install the old version of Kurzweil 3000. If yes, insert that version’s Key Disk.

4. At the prompt, click Yes to all to remove all program-related files.

5. If you have the Key Disk in the disk drive, remove it now.

6. Reboot the computer after uninstalling each old version of Kurzweil 3000 before installing a new version.

Important Note: If you decide to install the new version along with a previous version of Kurzweil 3000, both versions are visible in the Add or Remove Programs Control Panel. If, at some point you remove the older version, you will also disable the current version. If this happens, when you launch Kurzweil 3000, it prompts you to repair the current version, which you can do by inserting the Kurzweil 3000 DVD and clicking the Repair option in the Installation dialog.
Uninstalling Previous Versions of VoiceText

If you previously installed VoiceText, which was included with Kurzweil 1000 or with the VoiceText add-on CD (first available as a separate purchase with Kurzweil 3000 Version 8), you must uninstall it before installing the current version of Kurzweil 3000.

To uninstall an older version of VoiceText:

1. Login as Administrator.
2. From the Windows Start menu, go to Control Panel Add/Remove Programs.
3. Find, select and Remove Neospeech of VoiceText.msl.

Microsoft Speech Platform

Kurzweil 3000 Version 13 has added support for the Microsoft Speech Platform Runtime 11 Voices. Microsoft Speech Platform delivers access to more than a dozen additional voices in a variety of languages. You can choose and adjust the many voice options to suit your individual preference.

Installation

Microsoft Speech Platform is included on the Kurzweil 3000 DVD in a folder named "MicrosoftSpeech". A setup program is provided by Microsoft which handles the installation.

Note: These voices are not supported by Windows XP, but can be used with Windows Vista, Windows 7, and Windows 8.
Installing Kurzweil 3000 on Client Computers

Use one of the following installation options to install Kurzweil 3000 on each Client computer that you want to have access to a designated Kurzweil 3000 Network Engine.

There are two Client installation options:

- Install on a computer-by-computer basis.
- Install using “ghosting.” See Installing Kurzweil 3000 Using the Silent Install Option on page 37.

This guide only provides detailed instructions for installing the Client software using the computer-by-computer method. The other method should be performed only by experienced System Administrators.

To install Kurzweil 3000 on a Client computer:

1. Obtain the static IP address of the Kurzweil 3000 Network Engine computer for this procedure. See Determining the Static IP Address of an Engine Computer on page 19.

2. Ensure that there is no previous version of Kurzweil 3000 installed on this Client computer. If there is, see Uninstalling Previous Versions of Kurzweil 3000 on page 32.

3. Open Network Neighborhood to check if the Kurzweil 3000 Network Engine computer is accessible. If it isn’t listed, check the network setup.

4. Place the Kurzweil 3000 DVD in the Client computer’s DVD drive.

5. Double-click the Setup file.
6. In the **Master Installation** dialog, select **Network Software**.

7. In the **Network Software** dialog, select **Install Network Client Software**.

8. In the **NetworkBrowser Utility** window, type in the Kurzweil 3000 Network Engine computer's static IP address.

9. Click **OK** when you are done.

10. In the next window, click **Yes** to confirm the selected computer.

11. When the process is complete, click **Finish**.
The Kurzweil 3000 program shortcut appears on the desktop.

The next time a user starts Kurzweil 3000 at this Client computer, it automatically connects to the Engine.

12. The system may prompt you to **Restart**.

13. Remove the DVD.

14. Repeat this procedure for each Client computer on the Network.

**Notes:**

- The installation includes the VoiceText speaking voices.
- If at some time you need to point a Client at a different Engine, see *Changing the Engine IP Address for Clients* on page 98.
- If, for some reason, you need to uninstall the Kurzweil 3000 Network software, see *Uninstalling the Kurzweil 3000 Client and Engine Software* on page 83.
- If you are an Administrator user, whenever you launch Kurzweil 3000, the system checks for the latest software update. If one is found, you can opt to do one of the following:
  - Choose **No** to not install the update and have Kurzweil 3000 launch normally.
  - Choose **Don't Ask Me Again** to disable future auto update system checks.
  - Choose **Yes** to install the update now. Once the install is complete, Kurzweil 3000 launches.

**Installing Kurzweil 3000 Using the Silent Install Option**

**To install Kurzweil 3000 using the remote silent install option:**

The remote silent install installs Kurzweil 3000 to Client computers across a Local Area Network from a central location. This option is provided for Network Administrators who are knowledgeable about MSI packages and have the necessary tools to operate directly on an MSI package.
Microsoft .Net Framework 3.5 must already be installed before using MSI.

You will need to specify the following arguments as properties to the Kurzweil 3000 msi package.

AUTO = 1 (should be a numeric value)

EDITION = "net"

AUTOUPDATE = 0 sets the automatic software update to No updates; using 1 sets automatic software update to Yes.

PRODUCT = "scan"

SERVER = the IP address of a computer running a Kurzweil 3000 Network Engine, for example 127.0.0.1.

An example to launch Version 13 through command line follows:

msiexec.exe /i "Kurzweil 3000 v.13.msi" AUTO=1 EDITION="net" AUTOUPDATE=0 PRODUCT="scan" SERVER="127.0.0.1" /qn where /i is the install switch and /qn is the Silent UI switch.

Installing Clients Using Ghosting

You can also use “ghosting” to install Clients, eliminating computer-by-computer installation. Using this method, you would install the Client software on one computer, then copy the entire contents of that computer’s hard drive to subsequent computers on the network.

Note: Installation using ghosting should be performed only by advanced users or experienced IT personnel.

Testing Your Network Setup: Logging On

Once you install the Kurzweil 3000 Network Engine and at least one Client, you can test your setup by trying to log on to the Network from a Client computer.

To log on to a Kurzweil 3000 Network:

1. Go to a Kurzweil 3000 Client computer.
2. On the Client desktop, double-click the Kurzweil 3000 shortcut icon.
Depending on the options selected in the **Network Options** dialog box, Kurzweil 3000 either starts up or a **Log On** dialog box appears.

3. Enter log in information:

   If the **Log On** dialog appears, depending on the options selected in the **Network Options** dialog box, you will need to supply user name and/or product type information:

   **Username**: As you are adding a new user, type a name in the **Username** box, and click **OK**. Kurzweil 3000 adds the name to the **Username** list. Subsequently, each time you want to log on, you can just select the name from the list.

   Remember, the **Username** list is available only if **Show Username List to Clients** is selected in the **Network Options** dialog box. Otherwise, you must type in your user name each time you log on to the Network.

4. Click **OK**.

   If you now check the Administrator, you will see the new user in the **User** list.

   To review Network options, see the information starting with **Setting User Logon and Client Options** on page 25.

   **Note**: Kurzweil 3000 Clients include the **Change User** command in the **File** menu. This command is unavailable if you selected the **Use Windows Logon Name** option in the **Network Options** dialog box.

   Conversely, if you selected the **Ask for Kurzweil 3000 Username** and **Allow Clients to Create New Accounts** options in the **Network Options** dialog box, you can use the **Change User** command to create a new account.

   **Note**: If, for some reason, you need to uninstall the Kurzweil 3000 Network software, see **Uninstalling the Kurzweil 3000 Client and Engine Software** on page 83.
Additional Client Configuration Procedures

Perform the following procedures where appropriate to your site.

**Configuring Clients for Read the Web Access**

You must specify a **Port Exception** on Client computers running Windows XP with Service Pack 2 if your user community will use the Kurzweil 3000 Read the Web feature. See the procedure in *Installing and Configuring the Client Software* on page 32.
Installing the Kurzweil 3000 LAN Universal Library

The **Universal Library** is a folder that enables you to store documents that multiple users can share. This feature is ideal for distributing test or classroom material. If you are a teacher, once the Universal Library is set up, you can simply place the test or class assignment material in it and have the students open the document(s) from Kurzweil 3000.

Students who wish to access their own documents from any computer in the network should be sure to save documents to the **Universal Library** folder.

**To create the Universal Library folder:**

To use the Universal Library, you must first create the **Universal Library** folder on a computer.

1. Insert the Kurzweil 3000 DVD into the DVD drive.

2. Open the **Software** folder, open the **Utilities** folder, then double-click **HostLibraryWizard**.

3. In the **Universal Library Wizard** screen, click **Create**.

4. In the **Universal Library Created** screen, click **OK**.

5. For each computer for which you want access to the Universal Library, do the following:
   - Insert the Kurzweil 3000 DVD into the DVD drive.
   - From the **Software/Utilities** folder, double-click **ClientLibraryWizard**.
   - Follow the prompts.
When the user starts the computer again, the Kurzweil 3000 Universal Library folder icon will be in the Places pane of the Open dialog, and the File menu will contain the Open from and Save to Library commands.

6. For each computer for which you want access to the Universal Library, Configure the Library. Refer to Configuring Access to a Universal Library Folder on page 42, for information on giving Client computers access to the Universal Library folder.

### Configuring Access to a Universal Library Folder

Once you have installed the Universal Library folder, you need to provide access to it from each computer that will use it. See Installing the Kurzweil 3000 LAN Universal Library on page 41.

By default, the folder is named Kurzweil 3000 Universal Library, and it is installed at the top level of the C drive during the Universal Library installation process.

**To set up access to a Universal Library folder:**

1. Start Kurzweil 3000 on the computer on which you want to set up Library access.

2. From the File menu, select Configure Library.

   The Configure Universal Library dialog box appears.

3. Click Change.

4. In the Browse for Folder dialog box, navigate to and select the Kurzweil 3000 Universal Library folder, and click OK.

5. You should now see that the commands Open from Library and Save to Library have been added to the File menu.
To open documents from the Universal Library:

From the **File** menu, choose **Open from Library**.

The **Open** dialog box appears with the **Universal Library** folder as its starting point. Open any document as usual.

**To save documents in the Universal Library:**

1. From the **File** menu, choose **Save to Library**.

   The **Save As** dialog box appears with the **Kurzweil 3000 Universal Library** folder as its starting point.

2. Either navigate to the location where you want to save the document or click **Save** to save the document in the **Universal Library** folder.

   If you are saving the document in the **Universal Library** folder and the document that you are saving is one that already exists in the folder, for example *science worksheet*, be sure to rename the document so you don’t overwrite this public copy. For example, you might save the document as *jerry smith’s science worksheet*. 
Installing Remote Copies of the Administrator

You can install additional copies of the Administrator on any computers that can access the Kurzweil 3000 Engine over your LAN. This allows teachers to manage licenses and use other Network features, such as Send and Leave Messages and Force Toolbars.

**Note:** When the Administrator is run on a computer that does not also have the Kurzweil 3000 Engine software installed (remote mode), the Reports menu is unavailable. These functions can be initiated only from an Administrator running on a Kurzweil 3000 Engine computer (local mode). See *Local Versus Remote Administration* on page 47.

**To install only the Administrator:**

1. Place the Kurzweil 3000 DVD in the DVD drive.
2. Double-click the **Setup** file.
3. In the **Master Installation** dialog, select **Network Software**.
4. In the **Network Software** window, select **Install Network Remote Administrator**.
5. Follow the prompts until the installation process is **Finished**.

For more information on using the Administrator, see *About the Kurzweil 3000 Network Administrator* on page 47.
What’s Next?

After you have installed the Kurzweil 3000 Network Engine and Clients and verified that you can access the Engine from your Client computer(s), go to Administering the Kurzweil 3000 Network on page 46 to learn how to add Kurzweil 3000 Network users, how to change logon options and how to use the administration and reporting functions available to you with the Kurzweil 3000 Network Administrator tool.

In addition, the appendices provide information for setting up Read the Web, Kurzweil 3000 Taskbar and Universal Library for users.
3 Administering the Kurzweil 3000 Network

This chapter includes the following topics:

- About the Kurzweil 3000 Network Administrator on page 47.
- About the Network Options Dialog Box on page 55.
- Administration Procedures on page 56.
- Using License-to-Go on page 69.
- Returning a License-to-Go License to the Engine on page 76.
- Ensuring License Availability on page 78.
- Uninstalling Floating Licenses on page 80.
- Administering the Activity Database on page 85.
- Creating Database Reports and Form Letters on page 89.
- Kurzweil 3000 Network Engine Service on page 97.
- Changing the Engine IP Address for Clients on page 98.
- Uninstalling the Kurzweil 3000 Client and Engine Software on page 83.
About the Kurzweil 3000 Network Administrator

The Kurzweil 3000 Network Administrator (Administrator) is a tool that lets you accomplish Network administration and license management tasks. Additionally, you can configure the Kurzweil 3000 Network Engine to track students' activities as they use different Kurzweil 3000 features, letting you provide teachers with reports and individualized letters on students' progress.

Local Versus Remote Administration

You can install the Administrator on any supported computer on your network. See Client Requirements on page 13.

If you use the Administrator to administer an Engine that is installed on the same computer, the Administrator is said to be running in local mode. If you use the Administrator to administer an Engine that is installed on another computer, the Administrator is said to be running in remote mode. See To run the Administrator in remote mode: on page 48.

You can perform all Network tasks with the Administrator running in local mode. However, if you are running in remote mode, you cannot use the reporting and form letter features. See Generating Reports on page 89 and Creating and Generating Form Letters from the Database on page 92.

To launch the Administrator (local mode):

On a computer running the Engine software, double-click the Kurzweil 3000 Administrator desktop shortcut icon.

By default, the Administrator connects to the Engine installed on the local computer.
The **Administrator** appears:

![Administrator interface](image)

The **Administrator** interface consists of the following functional areas:

- **Menu** bar along the top includes the **File**, **Users**, **Tools**, **Licenses**, **Reports** and **Help** menus. See *About the Administrator Menus* on page 49.
- **Users** area lists the name of each user currently logged on to the Kurzweil 3000 Network, along with the name of the Client computer.
- The **Status** bar at the bottom displays the current lock status and shows the number of licenses in use.

**To run the Administrator in remote mode:**

1. Launch the **Administrator**.
2. From the **Tools** menu, choose **Options**.

   The **Network Options** dialog box appears and prompts you to enter an IP address for a Kurzweil 3000 Engine computer.
3. In the **Administrator Options** area, type the IP address of the computer on which the Kurzweil 3000 Engine you want to administer is installed.

   ![Administrator Options](image)

   By default, the **Auto-Refresh Display** option is selected, causing Kurzweil 3000 to refresh the user list every 15 seconds. If you are administering an Engine that has more than 100 connected users, you might want to disable this option, as the refresh period can take a few seconds, and this will increase with more connections.

   Even if **Auto-Refresh Display** is disabled, you can always refresh the display manually by selecting **Refresh View** from the **Tools** menu.

4. **Click OK**.

5. **Exit** and **Restart** the Administrator, as prompted.

After restarting the Administrator, you will see that the IP address of the <Kurzweil 3000 Administrator Console> user changes from that of the local computer to the IP address of the remote computer, and that the **Reports** menu's commands are now unavailable. Other than that, the Administrator's interface is identical to that shown on page 48.

**About the Administrator Menus**

The Administrator has six menus: **File, Users, Tools, Licenses, Reports** and **Help**.

**File Menu**

Use the **File** menu to exit from the Administrator.

**Users Menu**
The **Users** menu provides the following functions:

<table>
<thead>
<tr>
<th>Users Menu Item</th>
<th>Used to</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select All</td>
<td>Select all of the users displayed in the <strong>Users</strong> area window.</td>
<td></td>
</tr>
<tr>
<td>Unselect All</td>
<td>Deselect all of the users displayed in the <strong>Users</strong> area window.</td>
<td></td>
</tr>
<tr>
<td>Send Message</td>
<td>Send messages to currently logged-on Network users.</td>
<td>See <a href="#">Sending Messages</a> on page 62.</td>
</tr>
<tr>
<td>Leave Message</td>
<td>Send a message to any Network user, whether they are logged on or not.</td>
<td>See <a href="#">Leaving Messages</a> on page 63.</td>
</tr>
<tr>
<td>Force Toolbar Set</td>
<td>Load a selected toolbar set for selected users.</td>
<td>See <a href="#">Forcing a Toolbar Set</a> on page 64.</td>
</tr>
<tr>
<td>Disconnect</td>
<td>Disconnect users selected in the <strong>Users</strong> area window.</td>
<td>See <a href="#">Disconnecting Users from the Engine</a> on page 58.</td>
</tr>
<tr>
<td>Add New</td>
<td>Add new users.</td>
<td>See <a href="#">Adding Users from the Engine Computer</a> on page 59 and <a href="#">Adding Users from a Kurzweil 3000 Client Computer</a> on page 61.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete users.</td>
<td>This function is not available when the Engine is unlocked. See <a href="#">Deleting Users from the Engine</a> on page 67.</td>
</tr>
</tbody>
</table>
**Tools Menu**

The **Tools** menu provides the following functions:

<table>
<thead>
<tr>
<th>Tools Menu Item</th>
<th>Used to</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh View</td>
<td>Update the Users list.</td>
<td>The Administrator automatically updates the User list every 10 seconds. You can also update the list manually; see <em>Displaying Current Users</em> on page 57.</td>
</tr>
<tr>
<td>Lock/Unlock Engine</td>
<td>Lock or unlock the Engine.</td>
<td>See <em>Locking and Unlocking the Engine</em> on page 58.</td>
</tr>
<tr>
<td>Options</td>
<td>Open the Network Options dialog box.</td>
<td>See <em>About the Network Options Dialog Box</em> on page 55.</td>
</tr>
</tbody>
</table>
## Licenses Menu

The **Licenses** menu provides the following functions:

<table>
<thead>
<tr>
<th>Licenses Menu Item</th>
<th>Used to</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Management</td>
<td>Install and uninstall floating licenses.</td>
<td>See <em>Uninstalling Floating Licenses</em> on page 80.</td>
</tr>
<tr>
<td>License Overruns</td>
<td>Display Client connection refusal information (date, time, user) due to license unavailability.</td>
<td>See <em>Determining License Requirements</em> on page 82.</td>
</tr>
<tr>
<td>Grant a License-to-Go</td>
<td>Provide Kurzweil 3000 access to users after they disconnect from the Network.</td>
<td>See <em>Using License-to-Go</em> on page 69.</td>
</tr>
<tr>
<td>Generate Remote License-to-Go</td>
<td>Create a Remote License-to-Go code used to activate a Remote Kurzweil 3000 Client.</td>
<td>See <em>Transferring Licenses Using Remote Code Generation</em> on page 72.</td>
</tr>
<tr>
<td>Return Remote License-to-Go</td>
<td>Used to return a Remote License back to the Engine.</td>
<td></td>
</tr>
<tr>
<td>License-to-Go Status</td>
<td>Display a list of currently checked-out licenses and the users to whom they are issued.</td>
<td>See <em>Displaying Information About License-to-Go Licenses</em> on page 78.</td>
</tr>
</tbody>
</table>
Reports Menu

The Reports menu provides the following functions:

<table>
<thead>
<tr>
<th>Reports Menu Item</th>
<th>Used to</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Database</td>
<td>Save the temporary student activity log into the activity database.</td>
<td>See <em>Updating the Database</em> on page 88.</td>
</tr>
<tr>
<td>Run Report</td>
<td>Generate student activity reports.</td>
<td>See <em>Generating Reports</em> on page 89.</td>
</tr>
<tr>
<td>Database Cleanup</td>
<td>Delete database records.</td>
<td>See <em>Cleaning Up the Database</em> on page 88.</td>
</tr>
<tr>
<td>Add/Edit Form Letter Template</td>
<td>Create a form letter template that includes information merged from the student database.</td>
<td>See <em>Creating Database Reports and Form Letters</em> on page 89.</td>
</tr>
<tr>
<td>Generate Form Letters</td>
<td>Generate form letters from a form letter template.</td>
<td>See <em>Creating Database Reports and Form Letters</em> on page 89.</td>
</tr>
</tbody>
</table>

Help Menu

The Help menu provides the following functions:

<table>
<thead>
<tr>
<th>Help Menu Item</th>
<th>Used to</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
<td>Launch the Kurzweil 3000 Network online Help.</td>
<td></td>
</tr>
<tr>
<td>Online Registration</td>
<td>Connect to the Kurzweil Educational Systems registration website over the Internet.</td>
<td>Requires Internet access. Requires Internet access. Use this to update contact information so that we can inform you of important product updates and other news.</td>
</tr>
<tr>
<td>Help Menu Item</td>
<td>Used to</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>About Kurzweil 3000 Engine</td>
<td>Provide version and Kurzweil Educational Systems contact information.</td>
<td></td>
</tr>
</tbody>
</table>
About the Network Options Dialog Box

The **Network Options** dialog box provides settings that allow you to tailor the way users log on to the Kurzweil 3000 Network, to selectively lock features on Kurzweil 3000 Clients and to enable user activity logging.

The **Network Options** dialog contains the following options:

- Ask for Kurzweil 3000 User Name.
- Use Windows Logon Name.
- Show User Name List.
- Allow Clients to Create New Accounts.
- Allow Clients to Select License Type.

See **Setting User Logon and Client Options** on page 25 for information about the above options.

- **Administrator Options**. See **To run the Administrator in remote mode** on page 48.
- **Broadcast Lock Features Settings**. See **Broadcasting Feature Locks** on page 65.
- **Log User Statistics**. See **Administering the Activity Database** on page 85.
Administration Procedures

This section details the administration procedures that you can perform using the Administrator.

Use the following general steps when you need to perform system administration and reporting tasks:

1. Launch the Administrator.
2. Refresh user list.
3. Disconnect users from the Engine (if required).
4. Lock the Engine (if required).
5. Perform administration and/or reporting task(s).
6. If it is locked, unlock the Engine.
Displaying Current Users

It is always a good idea to refresh the user list before beginning system administration tasks. This provides you with the most up-to-date list of users and insight into whether it is a good time to perform administration tasks.

From the Tools menu, choose **Refresh** to see a list of users who are currently logged on to the Kurzweil 3000 Network.

By default, the User(s) area always displays the **Kurzweil 3000 Administrator** account.

The Kurzweil 3000 Administrator Account

The Kurzweil 3000 Administrator account always appears as logged on, enabling you to perform system administration tasks. You cannot disconnect the Kurzweil 3000 Administrator.

**Note:** The person designated to administer the Kurzweil 3000 Network should have Windows Administrator privileges. Administrator privileges are required for performing such tasks as installing and uninstalling licences.
Disconnecting Users from the Engine

When you need to perform administration tasks such as deleting users or updating the student database, you must disconnect all users currently logged on to the Kurzweil 3000 Network. However, you may also disconnect selected users if necessary.

You might also want to disconnect users when you need to do maintenance on software or hardware that is located on the same computer as the Kurzweil 3000 Network Engine.

To disconnect users from the Engine:

1. Double-click the Kurzweil 3000 Network Administrator desktop shortcut icon.
2. In the Administrator, select the names of the users in the Current Users box. If you want to disconnect all users, choose Select All from the Users menu.
3. From the Users menu, choose Disconnect.

   The selected users are disconnected and the Engine displays the following message on each user’s computer monitor:

   ![Message](image)

4. You can now lock the Engine.

Locking and Unlocking the Engine

When the Engine is unlocked, you can perform the following tasks:

- Disconnect currently logged-on users.
• Send messages to currently logged-on users.
• Leave messages for Network users, whether they are logged on or not.
• Install Licenses and uninstall Licenses.
• Force a Toolbar Set.

The Engine must be locked to perform the following tasks:
• Update the database.
• Delete users.

To lock and unlock the Engine:
1. From the Users menu, choose Select All.
   All of the currently logged-on users are selected in the User(s) area of the Administrator.
2. From the Users menu, choose Disconnect.
3. From the Tools menu, choose Lock Engine.
4. Perform the desired task(s).
5. When you are finished, choose Unlock Engine from the Tools menu to allow users to access the Network again.

Adding Users from the Engine Computer

Use the following procedure to add users with the Administrator on a Kurzweil 3000 Engine computer.

You can also add users from Clients. See Adding Users from a Kurzweil 3000 Client Computer on page 61.

Note: A Network Engine can support up to 32,000 user accounts.
Generating Multiple User Accounts from a Master File

If your Network has a large number of users, it may be preferable to create their accounts by loading a master user name file to the Engine.

The file should be plain ASCII text and contain one Kurzweil 3000 user name per line. The Engine will then take this file, validate each user name, and create an account with that name if it is a valid name and not already in use.

To add user(s) from the Engine:

1. Double-click the Kurzweil 3000 Network Administrator desktop shortcut icon.

2. From the Users menu, choose Add New.

   The Add New Users window appears

   ![Add New User Window](image)

3. Type the user’s name and click Add, then Yes to confirm.

   Alternatively, click the File button to bulk load a previously prepared master list of user names to the Engine.

4. Continue adding users, then click Done.
Adding Users from a Kurzweil 3000 Client Computer

By default, you can create new user accounts from Client computers as well as from an Engine computer. You can delete users only with an Administrator running on the same computer as the Engine.

To add a user from a Client:

1. Double-click the **Kurzweil 3000** shortcut icon on the desktop.

2. In the Log On window, type the desired user name, then click **Yes** to confirm.

   Kurzweil 3000 launches.

3. Click **OK** to close the **Options** dialog box.

Notes:

- You can disable the ability to create new accounts from Clients by deselecting the **Allow Clients to Create New Accounts** option in the **Network Options** dialog box. See Setting User Logon and Client Options on page 25.

- If the **Use Windows Logon Name** option is selected in the **Network Options** dialog box, the Engine automatically creates the new account as long as the **Allow Clients to Create New Accounts** option is enabled. See Setting User Logon and Client Options on page 25.
Sending Messages

The Send Message feature allows you to send a message to any user who is currently logged on to the Network. You do not have to lock the Engine to send messages.

To send a message:

1. Double-click the Kurzweil 3000 Network Administrator shortcut icon on the desktop.

2. In the Network Administrator, choose the names of the users in the Current Users box to whom you want to send a message. You can do this in one of two ways:
   - Hold down the CTRL key and click the desired names.
   - Or choose Select All from the Users menu.

3. From the Users menu, choose Send Message.

4. In the Send Message to User box, type your message, then click Send.

The message appears at the recipients’ workstations. Users can close the message box by clicking OK.

Note: You do not have to send out a message to inform users that you are going to disconnect them from the Network; a disconnect warning message is sent automatically. The message informs users that they can keep working for five minutes. After five minutes, they can only save their documents.
Leaving Messages

The Leave Message feature allows you to send messages to selected Network users, whether they are currently logged on to the Network or not. The message appears on each user’s computer monitor.

Message recipients who are not currently logged on receive the message the next time they log on to the Network. For message recipients who are currently logged on, you have the option of sending the message immediately or delaying delivery until the next time they log on.

To leave a message:

1. Double-click the Kurzweil 3000 Network Administrator shortcut icon.
2. In the Network Administrator, choose Leave Message from the Users menu.
3. In the Leave Message dialog box, type a message in the Message area.
4. In the Users area, choose the names of the users to whom you want to leave the message. To choose multiple names, hold down the CTRL key and click the desired names.
5. Choose Send message immediately to logged-on users (this option is selected by default) if you want selected users who are currently logged on to receive the message immediately. Deselect this option to delay message delivery until the next logon for each of the selected recipients.
6. Click OK to send and/or leave the message.
Forcing a Toolbar Set

The **Force Toolbar Set** feature enables you to select a toolbar set and one or more Network users, and then cause (force) that toolbar set to be displayed in the Kurzweil 3000 window of each of the selected users.

This feature can help reduce setup time for a test or other controlled classroom exercise that will be taken on multiple Kurzweil 3000 Clients.

**To force a toolbar set:**

1. Double-click the *Kurzweil 3000 Network Administrator* shortcut icon.
2. In the *Administrator*, choose **Force Toolbar Set** from the *Users* menu.
3. In the **Force Toolbar Set** dialog box, choose the toolbar set that you want to force from the *Toolbar Set* list.

   The list displays all of the toolbars that are available to the Engine. This includes any toolbar created by a Network user.

4. In the *Users* area, choose the names of the users who will receive the selected toolbar set. To select multiple names, hold down the **CTRL** key and click the desired names.

5. Choose **Send toolbar set immediately to logged-on users** (this option is selected by default) if you want the toolbar set to be displayed immediately for users who are currently logged on. Deselect this option to delay display of the toolbar set until the next logon for each of the selected users.
6. Click **OK** to force the toolbar set.

**Notes:**

- Before you force a toolbar set in a testing situation, we recommend that you deselect the **Customization Enabled** option on the **Lock Features** dialog box on each Client computer on which the test will be taken. This prevents users from altering the forced toolbar.

- If **Customization Enabled** is deselected, the forced toolbar remains the only toolbar available to each of the selected users until you either force a new toolbar or re-select **Customization Enabled**, allowing users to choose a new toolbar.

- For more information about test preparation and administration, see Kurzweil 3000 online Help.

**Broadcasting Feature Locks**

The **Broadcast Feature Locks** function lets you use the Administrator to disable, enable or leave “as is” selected Kurzweil 3000 features on multiple Client computers. The broadcast process overrides the current settings in the **Lock Features** dialog box of each Client computer.

Also, when you enable **Broadcast Feature Locks**, the **Lock Features** dialog boxes of Kurzweil 3000 Clients can be displayed, but the settings cannot be changed.

Some scenarios where you might find this feature useful are as follows:

<table>
<thead>
<tr>
<th>Testing</th>
<th>Lock features such as <strong>Spell Check, Dictionary</strong> and <strong>Online</strong> lookup.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Document Protection</strong></td>
<td>Lock features such as <strong>Zone Editing, File Encryption</strong> and <strong>Save to Universal Library</strong>.</td>
</tr>
<tr>
<td><strong>Data Security</strong></td>
<td>Lock access to the <strong>Usage Log</strong>.</td>
</tr>
<tr>
<td><strong>User Interface Consistency</strong></td>
<td>Lock <strong>Customization</strong>.</td>
</tr>
<tr>
<td><strong>Tip:</strong> You might want to use this in conjunction with the Kurzweil 3000 <strong>Save Toolbars in Document</strong> feature. See online Help.</td>
<td></td>
</tr>
</tbody>
</table>
It is important to remember that when you lock Kurzweil 3000 features, the broadcast locks apply to all users on all Client computers.

**Note:** To display the Lock Features dialog box in a Kurzweil 3000 Client, choose Lock Features from the Tools menu.

**To broadcast feature locks:**

1. From the Tools menu, choose Options.
2. In the Options dialog box, select Broadcast Lock Features.
   
   This activates the Configure Features Locks button.
3. Click Configure Features Locks.

The Lock Features dialog box appears.

Each feature has an associated menu, which lets you select how the feature is handled on each Kurzweil 3000 Client computer.

Select:

**Client Setting** (the default) to direct the Engine not to broadcast a value for this feature. Selecting this option preserves the current setting for this feature, either enabled or disabled, in the Lock Features dialog box on each Kurzweil 3000 Client.

**Enabled** to unlock the feature in the Lock Features dialog box on each Kurzweil 3000 Client.
Disabled to lock the feature in the Lock Features dialog box on each Kurzweil 3000 Client.

4. After selecting the desired settings, click OK.

The Administrator will apply the locks to each Client during its next login. Clients that are currently logged in are not affected.

Important Note: If a user opens a document containing embedded locks (set using the Kurzweil 3000 Save Feature Locks with Document feature), these locks override Broadcast locks. In order to restore the Broadcast Locks, you must restart Kurzweil 3000.

Deleting Users from the Engine

To delete a user from the Engine:

Note: Deleting a user deletes the user’s personal preference settings that are stored on the Kurzweil 3000 Network Engine but does not affect the user’s working files.

1. Double-click the Kurzweil 3000 Network Administrator shortcut icon.

2. In the Administrator, disconnect any currently logged-on users.

3. From the Tools menu, choose Lock, to lock the Engine.

4. From the Users menu, choose Delete.

5. In the Delete User dialog box, choose the desired user name from the Name menu, click Delete, then Done.

6. From the Tools menu, choose Unlock Engine to allow users to access the Network again.
Note: You cannot delete a user who has a License-to-Go. You must wait until either the license expires or the user checks the license back into the Engine. See Using License-to-Go on page 69.

User Files and Personal Settings

When you add a new user, the Engine creates a folder with the user’s name in:

C:\Documents and Settings\All Users\Application Data\KESI\Kurzweil 3000 Engine\Users

Inside the folder, it creates files to store and track user preference settings.

Files the user creates, imports and works with in Kurzweil 3000 are stored at the Client computer in the following directory:

For Windows XP: C:\Documents and Settings\username\My Documents\KESI\Kurzweil 3000

For Windows Vista and Windows 7 and Windows 8:
C:\Users\username\Documents\KESI\Kurzweil 3000

Files users created in older versions of Kurzweil 3000 may be in:

C:\My Documents\Kurzweil Educational Systems\Kurzweil 3000\username
Using License-to-Go

When you use the License-to-Go feature, you essentially let a student borrow a Kurzweil 3000 Network license so that he or she can work with Kurzweil 3000 without having to be connected to the Network.

You can transfer a License-to-Go to any computer on which the Kurzweil 3000 Client software is already installed. There are two transfer methods: Granting and Remote Code Generation. The method you use depends on whether the computer on which the Client software is installed can access a Kurzweil 3000 Network Engine. For a short overview of the two methods, see About License-to-Go™ on page 9.

License-to-Go licenses are counted against the total number of available Network licenses. If you don’t have a large number of licenses, you must manage them carefully so that you don’t run short.

For example, suppose you issue licenses to students with laptops so they can use Kurzweil 3000 at home. If one or more of these students leaves his or her laptop at home and then logs on to the Network at school, each one is essentially using two licenses (until the License-to-Go expires), which might be a problem if you are working with a small number of licenses.

Transferring Licenses Using the Granting Method

The process of Granting a license lets you transfer a license to a Kurzweil 3000 Client computer that is connected to a Kurzweil 3000 Network.

If you want to transfer a license to a Kurzweil 3000 Client computer that is not connected to a Kurzweil 3000 Network, see Transferring Licenses Using Remote Code Generation on page 72.
To grant a license:

**Important Note:** the system clocks on the computer running the Engine and the Client machine to which a license is being granted must be within five minutes of each other or else the Engine will not grant the license. Use the Date and Time Control Panel to synchronize the times of the computers.

1. Double-click the **Kurzweil 3000 Network Administrator** shortcut icon.
2. In the **Current User(s)** area, click on the user to whom you want to grant the license.
3. From the **Tools** menu, choose **Grant a License-to-Go**.
4. In the **License Term** area of the **Grant a License** dialog box, specify the length of time for which the license will be active.
First click either the **Hour**, **Day**, **Week**, or **Month** button. Then choose the number of days, weeks or months from the menu list.

The **Projected Expiration** date changes in response to the term length you select.

5. Click **OK**.

Messages appear on both the Engine and Client verifying that a license was successfully granted. The Engine automatically disconnects the Client from the Network, and the Client is now in Standalone mode. The user can continue to work without any interruption.

The user can view the time remaining on the granted license by choosing **About Kurzweil 3000** from the **Help** menu.

**Note:** If the computer receiving the granted license is running XP Home and the user has **Limited User** permissions, the license transfer may not take place. In this event, the receiving computer displays an error message. To fix this problem, you must edit the user’s Security Properties so that **User (Everyone)** can write to **Documents and Settings\All Users\Application Data\KESI**.
Transferring Licenses Using Remote Code Generation

Use the Generate Remote License-to-Go Code option to transfer a license to a Kurzweil 3000 Client computer that does not have access to a Kurzweil 3000 Network. Although you can use this method to transfer a license to a computer that is connected to a Kurzweil 3000 Network, it is much easier to use the Granting method. See Transferring Licenses Using the Granting Method on page 69.

As the System Administrator, you or the student(s) to whom you will transfer licenses will perform the following general steps. Steps are identified by who performs them, either you, the System Administrator [SA], or the student [Student]:

1. [SA] gives the student the Kurzweil 3000 Install DVD and a copy of the Client installation instructions.
   
   **Note:** Consider making copies of the Kurzweil 3000 Install DVD.
   
   The Client installation instructions are detailed in Appendix A: Installing and Activating a Kurzweil 3000 Remote Client. These instructions cover Steps 2, 3, 4 and 7.

2. [Student] installs the Kurzweil 3000 Client software.
   
   The student uses the supplied Client installation DVD to install Kurzweil 3000. See Appendix A: Installing and Activating a Kurzweil 3000 Remote Client.

   
   The student determines his or her computer’s System Code.

4. [Student] provides a System Code to the System Administrator.
   
   The student supplies the System Code, either by e-mail or telephone.

   
   Use the Administrator to generate a Remote License-to-Go Code based on the supplied System Code.
6. [SA] supplies the student with the Remote License-to-Go Code. Contact the student, either by e-mail or telephone, and supply them with the code.

7. [Student] activates the Kurzweil 3000 Client software. The student uses the Remote License-to-Go Code to activate Kurzweil 3000.

Generating a Remote License-to-Go Code

After a student installs the Client software (Step 2), determines the System Code of his or her computer (Step 3) and provides you with that System Code (Step 4), you can generate a Remote License-to-Go Code.

To generate a Remote License-to-Go Code:

Use the Kurzweil 3000 Administrator to generate a License-to-Go Code from the provided System Code.

1. Start the Administrator.

2. From the Licenses menu, choose Generate Remote License-to-Go. The Generate Remote License-to-Go dialog box appears.

3. Select a User Name.

The User Name menu contains user names for all of the accounts currently registered by the Kurzweil 3000 Engine.
• Select a name from the list that the Administrator will associate with the Remote Code it generates.

If you want to issue a Remote Code for a user who is not on the list, exit this dialog box and create a new account in the Add New User dialog box available from the Users menu. Then return to this dialog box and choose the new user name from the menu.

• You also have the option of creating a Remote Code without specifying a user. If you want to generate this type of Remote Code, select the Allow Client to Select User Name checkbox.

When you generate a license with this option selected, it causes the Kurzweil 3000 Client to display the logon dialog box each time it is launched. This allows anyone to type a user name, create a Kurzweil 3000 account and use the Kurzweil 3000 Remote Client.

Note: It is recommended that you specify a user name as it will make it easier to keep track of who you’ve issued Remote Codes to when you view the License-to-Go Status dialog box. See Displaying Information About License-to-Go Licenses on page 78.

4. In the License Type area of the Generate Remote License-to-Go dialog box, choose a License Type.

You can choose any license type as long as there is one available on the Engine. Otherwise, the Administrator will not be able to generate a Remote Code.

5. Type in a System Code.

Type in a System Code obtained from a student who installed the Kurzweil 3000 Client software on a remote computer. See Determining the System Code of Your Computer on page 102.

6. In the License Term area of the Generate Remote License-to-Go dialog box, specify the length of time for which the license will be active.

First click either the Hour, Day, Week or Month button. Then choose the number of days, weeks or months from the menu list.
The **Projected Expiration** date changes in response to the term length you select.
Returning a License-to-Go License to the Engine

Normally, a License-to-Go license returns to the Engine automatically when it reaches its expiration date and time.

However, there might be times when license shortages on your Kurzweil 3000 Network require you to retrieve one or more remote licenses before they expire.

There are two ways to retrieve a License-to-Go License before it expires:

- Have the owner of the granted License-to-Go connect the computer on which the granted license resides back to the Network, and check the license back into the Engine.
- Have the owner of a Remote License-to-Go generate a Return Code which you can use to return the license to the Engine.

To return a granted License-to-Go to the Engine:

1. Have the student connect the computer on which the granted license resides to the Kurzweil 3000 Network.

2. Start Kurzweil 3000.

3. From the File menu, choose Check In License-to-Go.
   
   A dialog box appears, prompting you to verify that you want to return the license.

4. Click Yes.
   
   Another dialog box appears, notifying you that the license was returned successfully.

5. Click OK.
Returning a Remote License-to-Go Before It Expires

Returning a Remote License-to-Go consists of the following general procedures:

1. A student generates a **Return Code** on the Kurzweil 3000 Client computer, and provides the code to his or her teacher or System Administrator.

   The procedure for generating a Return Code is included on page 104 of *Appendix A: Installing and Activating a Kurzweil 3000 Remote Client*.

2. The teacher or System Administrator uses the Administrator to return the license by inputting the **Return Code**.

To return a Remote License-to-Go to the Engine:

1. Obtain a **Return Code** from the owner of a Remote License-to-Go.

2. Start the **Administrator**.

3. From the **Licenses** menu, choose **Return Remote License-to-Go**.

   The **Return Remote License-to-Go** dialog box appears.

4. Type the **Return Code** into the **License-to-Go Return Code** text box, and click **OK**.

   The Administrator verifies the code and returns the license to the Engine, where it is immediately available for reuse.
Ensuring License Availability

To ensure license availability on both the Engine and Clients, it is highly recommended that no one tamper with the clocks on either the Engine or Client computers while licenses are granted.

Tampering with a Client’s clock will cause a granted license to be deactivated (not lost) and Kurzweil 3000 to become inaccessible. A deactivated license can still be checked back into the Engine using the Check In License-to-Go command in the File menu.

Tampering with the clock of the Engine computer can result in expired licenses not regenerating as scheduled and becoming inaccessible for a period of time dictated by the Engine’s internal license security monitoring system.

Displaying Information About License-to-Go Licenses

You can display information about checked-out licenses. This is helpful if you find that you are running low on Network licenses and need to contact users who have License-to-Go licenses, to tell them to return their licenses to the Engine. See Returning a License-to-Go License to the Engine on page 76.

To display information about checked-out licenses:

1. From the Licenses menu, choose License-to-Go Status.

   The License-to-Go Status dialog box appears. It displays the name of each user to which a License-to-Go has been issued, when it was issued and when it will expire.

2. Click Print to print a copy of the log.
License Management and License-to-Go

Keep the following things in mind when using License-to-Go licenses:

• If a granted or generated license is lost, for example due to a hard drive failure on the Client machine, you cannot restore it to the Engine prior to its pre-assigned expiration date. The Engine automatically regenerates the “lost” license after its expiration date has been reached.

• You cannot uninstall the Engine if there are any licenses checked out.

• You cannot issue more than one License-to-Go to a user.

• You cannot uninstall any licenses of a product type if one or more licenses of that product type are currently checked out.
Uninstalling Floating Licenses

When uninstalling or “returning” floating licenses from the Engine to License Keys, keep in mind the following:

- The License Keys must be able to hold the number of licenses you want to return. For instance, if you want to uninstall 10 licenses, you won’t be able to do so to a License Key that originally stored five. It is possible, however, to uninstall three licenses onto a License Key that is designed to store 10 but that is currently holding seven.

For instructions on installing floating licenses, see Installing Floating Licenses on page 29.

To uninstall floating licenses:

1. Have ready the correct Kurzweil 3000 product License Key to which you want to uninstall. Product information is on the License Key.
2. Double-click the Kurzweil 3000 Network Administrator shortcut icon.
3. In the Network Administrator, choose Select All from the Users menu.
4. From the Users menu, choose Disconnect.
5. From the Licenses menu, choose License Management.
6. Insert the **License Key** and click **Read Key**.

The **License Management** window displays the Kurzweil 3000 product that’s on the License Key, the number of licenses that are currently on the License Key (**On Key**), the maximum number of licenses that the License Key can store (**Key Max**) and the number of licenses that are installed on the Kurzweil 3000 Network Engine.

![License Management Window](image)

7. Look at the **Key Max** field to determine that the License Key can accommodate the number of licenses you’re returning. You might need more than one License Key.

8. Click the **Uninstall** button that corresponds to the product licenses you want to uninstall.

9. In the **Uninstall Licenses to License Key** dialog box, type in the number of licenses to uninstall, click **OK**, then click **Yes** to confirm.
The **License Management** window updates and now displays the number of licenses that you uninstalled to the License Key.

10. Click **Done** to exit the **License Management** window.

**Determining License Requirements**

You may want to check on your license usage in the following situations to help you determine if and when your organization needs to purchase additional licenses:

- Periodically.
- When users begin to receive a message indicating that the system has reached capacity.
- When you launch the Kurzweil 3000 Network Administrator and receive a message indicating that there is a license overrun. This message window provides the option to view the overrun report.

**To check on license overruns:**

1. From the **Licenses** menu, choose **License Overruns**.

   The **License Overruns** window appears. It lists when license overruns occurred and the license type involved.

2. Click:

   - **Save To File** to preserve this list to a file for your records.
   - **Clear Data** to remove the data.
Uninstalling the Kurzweil 3000 Client and Engine Software

Use the following procedures to uninstall the Kurzweil 3000 Client and Engine software.

Always uninstall the Client software first. Once you uninstall the Engine software, the Network is unavailable to all Clients.

Uninstalling Kurzweil 3000 Client software does not affect any existing user documents or Kurzweil 3000 preferences files.

Before uninstalling the Engine software, you must uninstall any licenses that are currently installed unless you want to permanently discard these licenses. See Uninstalling Floating Licenses on page 80. Uninstalling the Engine software removes all user preferences files.

Uninstalling Kurzweil 3000 Client Software

You uninstall the Client software from each computer on which it is installed.

**Note:** If your configuration has both a Client and an Engine installed on the same computer and you want to uninstall this Client, you must uninstall all licenses before you uninstall this Client.

**Important Note:** If you installed the current version of Kurzweil 3000 along with a previous version, both versions are visible in the Add or Remove Programs Control Panel. If you remove the older version, you will also disable the current version. If this happens, when you launch Kurzweil 3000, it prompts you to repair the current version, which you can do by inserting the Kurzweil 3000 DVD and clicking the Repair option in the Install dialog box.

To uninstall the Kurzweil 3000 Client software:

1. Go to the Client computer from which you want to uninstall the software.
2. From the Windows Start menu, go to Control Panel Add/Remove programs.
3. Find, select and Remove Kurzweil 3000 from the list of programs.
4. Follow the prompts.
Notes for uninstalling on Vista and Windows 7 and Windows 8:

- From the Control Panel, use Programs Uninstall.
- Monitor the uninstall process; when you see the User Account Control dialog, click Allow to allow the program to be uninstalled.

To uninstall the Engine software:

1. From the Windows Start menu, go to Control Panel Add/Remove programs.
2. Find, select and Remove Kurzweil 3000 from the list of programs.
3. In the message box that appears, click Yes to confirm that you want to uninstall the Engine software.

   The uninstall process begins. If there are any licenses installed, a message appears warning you to either quit the uninstall program and uninstall the licenses back to the License Key, or proceed with the knowledge that the licenses will be destroyed.

4. Click OK to exit from the uninstall program so that you can uninstall the licenses, or click Destroy Licenses to continue the uninstall process.

   When the process is complete, a message appears prompting you to restart Windows.

5. Restart Windows.

Notes for uninstalling on Vista and Windows 7 and Windows 8:

- From the Control Panel, use Programs Uninstall.
- Monitor the uninstall process; when you see the User Account Control dialog, click Allow to allow the program to be uninstalled.
Administering the Activity Database

Important: The following sections contain valuable information for teachers. It is important that you as the System or Network Administrator inform teachers of the availability of the Reporting and Form Letter tools so that they can make use of them. To learn more about Reports and Form Letters, teachers can go to the online Help system.

You can configure the Kurzweil 3000 Engine to keep a record of students’ activities as they work. The Engine can record such actions as definition lookups, spell checking and reading speed changes. See What Activities Get Logged? on page 87 for a complete list of logged activities.

Using the Network Administrator, you or a teacher can perform the following database administration tasks:

• Update the database.
• Clean up the database.

After you have collected user activity data, you use it to generate reports and form letters that incorporate selected data, similar to a mail merge. See Creating Database Reports and Form Letters on page 89.

Note: If you are running the Administrator in remote mode, none of the Reports menu functions are available. The only database-related function you can initiate is to enable or disable activity logging. See Local Versus Remote Administration on page 47.

Enabling Activity Logging

By default, the Engine does not log user activity; you enable this function. Be aware that activity logging can require large amounts of disk space since the activity of all users is recorded. Therefore, you need to ensure that there is adequate free disk space available on the Kurzweil 3000 Engine computer. It is not possible to provide specific disk space requirements because of the variability of individual Kurzweil 3000 Network installations. However, space on the order of tens of megabytes is a suggested starting point.

Note: Statistics are not logged for users who are using Kurzweil 3000 with granted licenses.
To enable activity logging:

1. Double-click the Kurzweil 3000 Network Administrator shortcut icon.

   The Network Administrator appears.

2. From the Tools menu, choose Options.

3. In the Network Options dialog, in the Client Options area, select Log User Statistics.

4. Click OK to close the dialog box.
What Activities Get Logged?

The following is a list of Kurzweil 3000 activities and/or events that are logged in the activity database:

- File opened
- File saved
- File closed
- Page scanned
- Reading started
- Reading stopped
- Look up definition
- Look up synonyms
- Look up syllables
- Spell a word
- Spell check a document
- Word Prediction enabled
- Word Prediction disabled
- Word inserted from Word Prediction
- Reading Speed changed
- Read Mode changed
- Read Unit changed
- User logged in
- User logged out
- New Text File created
- New Image File created
- File "Saved As"
- Definition not found
- Look Up in Encarta
- Synonym not found
- Spell Check error replaced
- Spell Check error skipped
- Spell Check no suggestions for word
- Spell Check report
- Highlighter used on text
- Highlight words in Word List
- Search for words in Word List
- Word inserted from Word List
Chapter 3. Administering the Kurzweil 3000 Network

Updating the Database

Student activity is saved in real-time to a log file named EventLog.log. To generate a report on this activity, you must move this information into the activity database using the Update Database command.

To update the database:

1. In the Kurzweil 3000 Network Administrator, disconnect all users and choose Lock Engine from the Tools menu.
2. From the Reports menu, choose Update Database.
   The Engine updates the database
3. From the Tools menu, choose Unlock to let users access the Network again.

After you move the activity information to the database, the log file is deleted. A fresh log file is created when users are again allowed to log on to the Network. You can run reports with the Engine unlocked.

Cleaning Up the Database

As the student database grows larger, you might want to delete outdated or unneeded activity information in order to conserve disk space. You can delete database information based on date.

To delete activity information from the database:

1. From the Reports menu, choose Database Cleanup.
   The Database Cleanup dialog box appears.

2. Type in a date. Use the format MM/DD/YY.
3. Click OK.

All information saved with a date previous to the input date is deleted.

Creating Database Reports and Form Letters

You can output the activity data you collect as either a report or as form letters. You generate form letters from a form letter template. Form letter templates consist of text that you type in manually and predefined database field tags that you embed inside the text.

See Creating and Generating Form Letters from the Database on page 92.

Generating Reports

The Kurzweil 3000 Network Engine includes several predefined reports that you can use to chart student progress. You can generate reports for individual students or for all students in the database.

<table>
<thead>
<tr>
<th>Report</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition Lookups</td>
<td>Specific words looked up.</td>
</tr>
<tr>
<td>Synonym Lookups</td>
<td>Specific words for which synonyms were found.</td>
</tr>
<tr>
<td>Syllable Lookups</td>
<td>Specific words broken into syllables.</td>
</tr>
<tr>
<td>Spell Check Errors</td>
<td>Specific words misspelled.</td>
</tr>
<tr>
<td>Reading Speed by User</td>
<td>Changes to reading speed.</td>
</tr>
<tr>
<td>Student Summary</td>
<td>Average reading speed, number of words looked up.</td>
</tr>
<tr>
<td>Full Database</td>
<td>All activity.</td>
</tr>
</tbody>
</table>

Also, if your school has Microsoft Access 97 or another database management application that is compatible with the Microsoft Jet database format, you can create your own customized reports. Consult your database software documentation for instructions.
To generate a Kurzweil 3000 report:

1. Double-click the Kurzweil 3000 Network Administrator shortcut icon.
2. From the Reports menu, choose Run Report.
3. In the Select Report dialog box, choose the report you want from the Report menu.
4. For a report on a single student, type the name in the User Name box. For a report on all students, leave the User Name box blank.
5. For a report covering a specific time period, scroll to select month and day, then type in the year for both Starting Date and Ending Date. For a report covering the entire time span in the database, leave these boxes blank.
6. Click OK.
7. When the report appears, click Print to send it to your printer or Exit Report to return to the Select Report window.

By default, the data in a report is in ascending chronological order (earliest to latest). To reverse the order, click the Date/Time column head. To resize the columns, click and drag the dividers between column heads.
Below are examples of a Definitions Lookup report for one student and a Spell Check report for a group of students:
Creating and Generating Form Letters from the Database

The Generate Form Letters feature gives you the ability to produce form letters from a form letter template that you have previously created.

A form letter template consists of manually entered “boilerplate” text merged with numeric data from the activity database, viewed over a specified time period. The numeric data corresponds to the number of times students used Kurzweil 3000 features such as Definition lookup or Word Prediction, and in the case of Reading Speed, the average reading speed.

This feature, which is similar to a mail merge, allows you to create, for example, weekly parent letters that detail a student’s interactions with Kurzweil 3000.

To create a form letter template:

The general method for creating a letter is to type “boilerplate” text that is appropriate for everyone who will receive the letter, insert database field tags, type labels for the inserted fields and type any desired explanatory text.

1. Double-click the Kurzweil 3000 Network Administrator shortcut icon.

   The Network Administrator appears.

2. From the Reports menu, choose Create/Edit Form Letter Template.

   The Select Form Letter Template dialog box appears.

3. Type a name for the template in the Letter Name box and click OK.
The Engine creates the new form letter template and adds the template's name to the Letter Name list for future use, and the Add/Edit Letter: Template Name dialog box appears.

The Add/Edit Letter: Template Name dialog box provides simple Font, [Font] Size and [Font] Style formatting tools. The Fields button provides access to the Insert Field dialog box.

4. Click Fields.

The Insert Field dialog box appears. The Field Name list contains a list of all the interactions stored by the database.
When you choose a field name, a description of the information it contains appears in the Field Description area.

5. Add field labels and any other desired text.

6. Click Close.

Form letter template sample.

Inserted database fields are enclosed by double angle brackets (<< >>), all other text is typed in manually.

Weekly Kurzweil 3000 Reading Report

To the parents of <<Student Name>>.

From <<Starting Date>> to <<Ending Date>> your child used Kurzweil 3000 for <<Time Using Kurzweil 3000>> minutes.

During this time, your child interacted with Kurzweil 3000 as follows:

Time spent reading was <<Active Reading Time>> minutes.

Average Reading Speed was <<Reading Speed>> words per minute.

Looked up <<Definition Lookups>> word definitions in the Kurzweil 3000 dictionary.

Looked up <<Encarta Lookups>> word definitions in Encarta.

Sincerely,

Ms. Lyons
Generating a Form Letter

After you have created a form letter template, you can direct the Engine to generate one or more form letters each of which will contain the selected user’s individual usage information.

To generate a form letter:

1. From the Reports menu, choose Generate Letters.

   The Form Letter Generator dialog box appears.

2. Choose a letter from the Letter Name menu.
3. In the **Students** area, choose the name of each student for whom you want to generate a letter. To choose multiple names, hold down the **CTRL** key and click the desired names.

4. Specify a **Starting Date** and an **Ending Date**. This range will appear on the cover sheet when you print the generated letters, and, within the letters themselves, if they contain the **<<Starting Date>>** and **<<Ending Date>>** database fields.

5. Click **OK**.

The **Form Letter Display** dialog box appears. The dialog box contains the header, which displays the name of the form letter followed by the specified date range. Following the header, the form letter is reproduced, now with the specified data replacing the field tags, one letter for each student you selected. A red line indicates the end of one letter and the beginning of the next.

6. Click **Print** to print all of the letters.
Kurzweil 3000 Network Engine Service

Kurzweil 3000 Network Engines are implemented as services to provide greater system stability and the ability to control certain administration tasks from a remote computer.

The Engine activities that you can administer include starting, stopping and restarting the Engine, and setting the service start-up type and service recovery action. All of these activities must be accomplished using the Microsoft Management Console (MMC).

By default, the Kurzweil 3000 Network Engine Service is set for “normal” use. You don’t need to alter the service unless you want to for greater convenience and flexibility.

The Kurzweil 3000 Engine service default settings are as follows:

• The service is set to **Started**.
• The startup type is **Automatic**.
• The service recovery action is set to **Take No Action**.

For complete details about service administration, consult your Windows operating system documentation.
Chapter 3. Administering the Kurzweil 3000 Network

Changing the Engine IP Address for Clients

There might be a time when you need to install the Engine on a different computer that has a different IP address. If you do, you will need to register this change on each Kurzweil 3000 Client.

There are two methods for making the change:

- Use the **NetworkBrowser** utility application.
- Edit the Registry of each Client computer.

**To change the IP Address with the NetworkBrowser utility:**

1. Insert the Kurzweil 3000 DVD into the Client computer.
2. Navigate to the **Utilities** folder on the DVD.
3. In the **Utilities** folder, double-click **NetworkBrowser.exe**.
   
   The **NetworkBrowser** window appears.
4. Type in the new IP Address, then click **OK**. Then click **Yes** to confirm the change.
5. Repeat this procedure on each Client computer on which you need to change the IP Address.

**To change the IP Address by editing the Registry:**

**Note:** Always backup your current registry settings before making any changes.

1. Run **regedit.exe**.
2. Navigate to **HKEY_LOCAL_MACHINE\SOFTWARE\KESI\Kurzweil 3000\Installed**
3. Double-click the **ServerName** entry on the right.
4. In the **Edit String** dialog box, type the new IP Address in the **Value Data** box.
5. Click **OK**.
6. Exit the **Registry Editor**.
A Installing and Activating a Kurzweil 3000 Remote Client

The purpose of this appendix is to guide students through installing and activating Kurzweil 3000 Client software using a Remote License-to-Go Code.

The appendix also includes instructions for returning a Remote-License-to-Go Code before it reaches its expiration date. See Returning a Remote License-to-Go Before It Expires on page 104.
Installation and Activation Overview

The installation and activation procedures include the following steps.

1. **Install the Kurzweil 3000 Client software on your computer.**
   
   Use the installation DVD provided by your teacher or System Administrator to install Kurzweil 3000 on your computer.
   
   See page 101 for instructions.

2. **Provide a System Code to your System Administrator.**
   
   After you install the software, Kurzweil 3000 displays a System Code. Give this code to your teacher or System Administrator so that he or she can generate a Remote License-to-Go Code for you.
   
   See page 102 for instructions.

3. **(Student/Client User) Activate the Kurzweil 3000 Client software.**
   
   Using the **Remote License-to-Go Code** provided by your teacher or System Administrator, activate Kurzweil 3000.
   
   See page 103 for instructions.
Appendix A. Installing and Activating a Kurzweil 3000 Remote Client

Installing the Kurzweil 3000 Client Software

Use the following procedure to install the Kurzweil 3000 Client software on a computer that is not connected to the Kurzweil 3000 Network.

To install the Client software:

1. Place the Kurzweil 3000 DVD in the DVD drive.
2. Double-click the Setup file.
3. In the Master Installation dialog, select Network Software.
4. In the Network Software window, select Install Network Remote Client Software.
5. Follow the prompts.
6. In the Network Browser Utility window, click Clear, then click Yes in the dialog box that appears.
7. Click Finish.
8. Restart the computer.
9. Remove the DVD.
Determining the System Code of Your Computer

To obtain a System Code:

A **System Code** is required by your teacher or System Administrator to generate a **Remote License-to-Go Code**, which you will use to activate the Kurzweil 3000 Client software.

1. After installing the Kurzweil 3000 Client software, click the **Kurzweil 3000** shortcut icon on the desktop.

2. In the **License-to-Go Code** dialog box that appears, write down the System Code and the Version Number.

3. Using either e-mail or telephone, supply the **System Code** and **Version Number** to your teacher or System Administrator.

4. Click **Cancel** to exit the dialog box.
Activating the Kurzweil 3000 Client Software

To activate the Client software:

Once you have communicated the System Code to you System Administrator, he or she will use it to generate a License-to-Go Code. Your System Administrator will then supply you with the License-to-Go Code so that you can activate your copy of Kurzweil 3000.

1. Click the Kurzweil 3000 shortcut icon on the desktop.

The License-to-Go Code dialog box appears.

2. Type the License-to-Go Code into the License-to-Go Code text box.

3. Click OK.

Kurzweil 3000 starts. Depending on the login option selected by your System Administrator, either the Kurzweil 3000 interface or the Login dialog box appears.

If the Login dialog box appears, type in a user name and click OK.

Note: When Kurzweil 3000 first starts, it displays the expiration date and time for the License-to-Go in the Status Bar at the bottom of the Kurzweil 3000 window.
Returning a Remote License-to-Go Before It Expires

There might be a time when your teacher or System Administrator will ask you to return your License-to-Go before it is due to expire.

To generate a Remote License-to-Go Return Code:

1. Start Kurzweil 3000.
2. From the File menu, choose Check In License-to-Go.
   A dialog box appears, prompting you to confirm that you want to check in the license.
3. Click Yes to continue.
   Another dialog box appears, informing you that there is no Kurzweil 3000 Engine available and asking if you want to generate a Return Code.
4. If you are sure you want to continue, click Yes. Once you click Yes, your copy of Kurzweil 3000 will be deactivated.
   Kurzweil 3000 generates a Return Code and displays it to you.
5. Contact your teacher or System Administrator and supply him or her with the Return Code.
B Setting Up Read the Web

Kurzweil 3000 **Read the Web** makes it possible to use the Kurzweil 3000 reading and reference tools with content in a Web browser.

When Kurzweil 3000 is first installed, there is no default browser selected to use with the **Read the Web** feature. You have the choice of using either Microsoft Internet Explorer or Mozilla Firefox (Firefox).

Use one of the following scenarios to select a default browser:

- If you have only Internet Explorer on your computer and you don’t want to use Firefox, go to *Selecting Internet Explorer as the Default Browser* on page 106.
- If you have both Internet Explorer and Firefox already installed on your computer, and you want to use Firefox, go to *Installing or Updating the KESIReader Firefox Extension* on page 109.
- If you don’t have Firefox on your computer but want to use it, go to *Installing the Firefox Browser* on page 107.

**Notes:**

- If Kurzweil 3000 detects Firefox on your computer and you choose **Read the Web** from the **Read** menu before following one of the selection scenarios above, Kurzweil 3000 will prompt you to install the **KESIReader** extension as detailed in *Installing or Updating the KESIReader Firefox Extension* on page 109.
- If you only have Internet Explorer and you choose **Read the Web**, Kurzweil 3000 automatically uses it as the default browser.
Selecting Internet Explorer as the Default Browser

If you want to specify Internet Explorer as the default browser used by Read the Web, do the following:

1. From the Tools menu, choose Options.

2. In the Options dialog box, click the Reading icon on the left to display the Reading Options pane.

3. In the Read the Web area, select Internet Explorer.
   
   **Note:** If Firefox is also installed on your computer, both radio buttons are available, and the Get Firefox button is not visible.

4. Click OK to close the Options dialog box.

For more information about Read the Web, see online Help.
Selecting Firefox as the Default Browser

To select Firefox as the default browser for Read the Web, you must first install it. After you install Firefox, you must then install the KESIReader Firefox extension. Both procedures can be done from within Kurzweil 3000.

Installing the Firefox Browser

If you do not have Firefox, you can install it from the Mozilla.com Web site.

If you already have Firefox on your computer, go to Installing or Updating the KESIReader Firefox Extension on page 109.

Note: If you are installing/updating Firefox for use with Limited/Restricted or Guest accounts, Firefox must be run once outside of Kurzweil 3000 for each account, in order for Read the Web to operate properly with a given account.

To install Firefox from the Mozilla.com Web site:

1. Log in as an Administrator.
2. From the Tools menu, choose Options.
3. Click the Reading icon on the left to display the Reading Options pane.
4. In the Read the Web area, click the Get Firefox button.
   Internet Explorer launches and opens the Firefox download page.
   Note: The URL for the Firefox download page is http://www.mozilla.com.
5. Click the Download Firefox link.
6. In the File Download dialog box, click Run.
   The download starts, and the setup files are copied to your computer. When the download is complete, the Security dialog box appears.
7. Click Run.
8. Follow the instructions in the Setup wizard.
9. Click Finish to exit from the wizard, and launch Firefox.
If this is the very first time you have ever installed Firefox, you are asked some questions related to making Firefox your default system browser. How you answer these questions has no effect on the functionality of the Read the Web feature.

10. Exit Firefox.

11. Exit Internet Explorer.

12. In Kurzweil 3000, click OK to close the Options dialog box.

Now go to Installing or Updating the KESIReader Firefox Extension on page 109.
Installing or Updating the KESIReader Firefox Extension

The KESIReader extension enables Read the Web to work with Firefox.

If you are updating Kurzweil 3000 from Version 9, you must first uninstall any previous versions of the KESIReader extension. See Uninstalling the KESIReader Firefox Extension on page 110.

To install or update the KESIReader extension:

1. From the Tools menu, choose Options.

   The Options dialog box appears.

2. Click the Reading icon on the left to display the Reading Options pane.

   If you installed Firefox successfully, the Read the Web area should look as follows:

3. Select Mozilla Firefox.
A message appears asking for permission to install the **KESIReader** extension.

4. **Click Yes.**

A second, similar install message appears.

5. **Click OK.**

6. In the Firefox **Software Installation** dialog box, click **Install Now.**

   The Extensions dialog box appears, displaying the **KESIReader** extension, confirming a successful installation.

7. **Close the Extensions dialog box.**

8. **Exit Firefox.**

9. **Click OK** to close the Kurzweil 3000 **Options** dialog box.

For more information about Read the Web, see online Help.

**Uninstalling the KESIReader Firefox Extension**

If you are updating from Kurzweil 3000 Version 9, you must uninstall any older version of the **KESIReader** extension.

**To uninstall the KESIReader extension:**

1. Start Kurzweil 3000 and choose **Read the Web** from the **Read** menu. Alternatively, you can launch **Firefox.**

   If you chose **Read the Web** in Step 1, Kurzweil 3000 displays a message informing you that you must upgrade the **KESIReader** extension. Click **OK.** Kurzweil 3000 launches Firefox.

2. In Firefox, choose **Extensions** from the **Tools** menu.

   The **Extensions** dialog box appears, displaying the currently installed version of the **KESIReader** extension.

3. **Click on the KESIReader extension to select it.**

   The **Uninstall** button becomes active.
4. Click **Uninstall**.

5. In the message box that appears, click **Yes** to confirm the operation.

   Firefox marks the extension for removal.

6. Exit from Firefox, restart it, then exit it again to complete the removal of the extension.

   Now go to *Installing or Updating the KESIReader Firefox Extension* on page 109.

**Updating the Firefox Extension**

As with most applications, the Mozilla Foundation will update Firefox from time to time.

When you update Firefox, you should also update the **KESIReader** extension.

**To update Firefox for use with Read the Web:**

1. Install the new version of Firefox.

2. Launch **Firefox**.

3. From the **Tools** menu, choose **Extensions**.

4. In the **Extensions** dialog box, select the **KESIReader** extension.

5. Click **Uninstall**.

6. Exit and restart **Firefox**. Then exit it again.

7. Start **Kurzweil 3000**.

8. From the **Online** menu, choose **Updates**.

9. Download and install the latest update(s).

10. Perform the **KESIReader** installation procedure detailed on page 109.
Setting Up the Kurzweil 3000 Taskbar

The Kurzweil 3000 Taskbar, an application that appears as a small bar in the Windows Taskbar, automatically installs with Kurzweil 3000.

The Kurzweil 3000 Taskbar in the Windows Taskbar

The Kurzweil 3000 Taskbar offers fingertip access to Read, Dictionary Look Up, Check Spelling, and the Image Reader. You can use it for a single word or for a large selection of text from any application, including the e-mail program and Web browser, that’s on your system.

**Note:** For the Network edition, you must have a valid user license or Kurzweil 3000 must be running.

For complete and detailed information on using Kurzweil 3000 Taskbar, place your cursor anywhere on the Kurzweil 3000 Taskbar and right-click to display its shortcut menu, and select Help.

**Showing or Hiding the Kurzweil 3000 Taskbar**

1. Click the right mouse button in an empty area of the Windows Taskbar to display the **Windows Taskbar Shortcut** menu.

2. From the **Toolbars** menu, click the **Kurzweil 3000 Taskbar** item.
Using the Kurzweil 3000 Taskbar

There are two ways to use the Kurzweil 3000 Taskbar:

1. Click the Kurzweil icon, type a word or phrase in the box, and click the Read, Lookup word, or Spell Check icon; or

2. Simply drag and drop text directly into the Read, Lookup word, or Spell Check icon in the Kurzweil 3000 Taskbar.

Kurzweil 3000 will automatically begin reading the text, dictionary entry, or correct spelling.

The Taskbar also contains a shortcut icon for the Image Reader. When you click it, you will be able to select an image to read.
D Setting Up the Universal Library

The Local Area Network (LAN) Universal Library is a folder that makes it possible to store documents that multiple users can share. This feature is ideal for distributing tests or classroom materials. Once the Universal Library is set up, teachers can place the test or class assignment material in it and have the students open the document(s) electronically.

Creating the Universal Library Folder

You can install a Universal Library folder in either of the following locations:

- A local, non-networked computer that has multiple users.
- A networked computer allowing users to access the library from other networked computers.

1. Insert the Kurzweil 3000 DVD into the DVD drive.

2. Open the Software folder, open the Utilities folder, then double-click HostLibraryWizard.

3. In the Universal Library Wizard screen, click Create.

4. In the Universal Library Created screen, click OK.
5. For each computer for which you want access to the Universal Library, do the following:

• Insert the Kurzweil 3000 DVD into the DVD drive.
• From the **Software/Utilities** folder, double-click **ClientLibraryWizard**.
• Follow the prompts.

When the user starts the computer again, the Kurzweil 3000 Universal Library folder icon will be in the Places pane of the Open dialog, and the File menu will contain the Open from and Save to Library commands.

6. For each computer for which you want access to the Universal Library, Configure the Library. Refer to **Configuring Access to a Universal Library Folder** on page 115, for information on giving Client computers access to the **Universal Library** folder.

### Configuring Access to a Universal Library Folder

Once you have installed the **Universal Library** folder, you need to provide access to it from each computer that will use it.

By default, the folder is named **Kurzweil 3000 Universal Library**, and it is installed at the top level of the C drive during the Universal Library installation process.

**To setup access to a Universal Library folder:**

1. Start Kurzweil 3000 on a computer on which you want to set up Library access.
2. From the **File** menu, select **Configure Library**.
   
   The **Configure Universal Library** dialog box appears.
3. Click **Change**.
4. In the **Browse for Folder** dialog box, navigate to and select the **Kurzweil 3000 Universal Library** folder, usually the C: drive.
5. Click **OK**.
You should now see that the commands **Open from Library** and **Save to Library** have been added to the **File** menu.

**Using the Universal Library**

**To open documents from the Universal Library:**

- From the **File** menu, choose **Open from Library**.
- The **Open** dialog box appears with the **Universal Library** folder as its starting point. Open the desired document as usual.

**To save a document in the Universal Library:**

1. From the **File** menu, choose **Save to Library**.
- The **Save As** dialog box appears with the **Kurzweil 3000 Universal Library** folder as its starting point.
2. Either navigate to the location where you want to save the document or click **Save** to save the document in the **Universal Library** folder.
## Index

### A
- accessing
  - Universal Library 43, 116
- accounts, maximum supported 59
- activity logging
  - disk space requirements 85
  - enabling 85
  - EventLog.log file 88
  - types of events logged 87
- Add or Remove Programs window 21, 83, 84
- Add/Edit Form Letter Template dialog box 93
- adding
  - new users from a master file 60
  - users 58
  - users from the Client 59
  - users from the Network Engine 59
- administration procedures, general 56
- Administrator options
  - Allow Clients to Change Product Types 28
  - Allow Clients to Create Accounts 28
  - dialog box 26
  - Log User Statistics 86
  - Show User Name List to Clients 26
  - User Logon Name 26
- Allow Clients to Change Product Types option 28

### B
- Auto-Refresh Display option 49
- Broadcast Feature Locks, about 65

### C
- Change User command (client) 39
- changing, client's target engine 37
- Cleanup Database command 88
- Client
  - about 1
  - adding users from 59
  - Change User command 39
  - computers 6
  - connection problem 24
  - forcing toolbars to 64
  - requirements 13
  - uninstalling Version 10 83
- configuring
  - Universal Library 115
- configuring the Universal Library
  - on a networked machine 41
- configuring, Windows firewall 24
- creating
  - form letters 92
  - reports 88
- current users, displaying 57

### D
- database 85
conserving disk space 88
deleting information from 88
  log file 88
  turning on activity logging 85
  updating 88
database printout 89
databases
  Microsoft Access 97 89
  supported by Kurzweil 3000 89
Definition Lookup report 89
  example 91
deleting
  information from the database 88
  users 58, 67
  users’ personal preference settings 67
designating a Network Engine 18
determining
  license requirements 82
  license usage 82
disconnecting users 58
displaying current users 57
documents
  accessing from Universal Library 116
  accessing in Universal Library 43
  saving to Universal Library 116
dynamic IP address 19

E
Engine
  about 1
  desktop icon 47
  disconnecting users 58
  generating reports 88
  locking and unlocking 58
  maximum number of accounts 59
  sending messages from 62
  service 97
  unavailable message 24
  uninstalling Version 10 84
  with Service Pack 2 24
Engine Not Available message 24
Engine, about 18
EventLog.log file 88

F
feature locks, broadcasting 65
File menu 49
Firefox 107
  installing from Mozilla.org Web site 107
  updating 111
  with Limited or Guest accounts
    (see Note) 107
floating licenses (see licenses)
forcing toolbar set 64
  in conjunction with test taking 65
form letter
  Add/Edit dialog box 93
  adding database fields to 93
  creating 92
  generating 95
  template 92
  template sample 94
Full Database report 89

G
generating reports 88, 90
generating student activity reports 88
ghosting, using to install client software 38
granted licenses
  and activity logging 85
displaying information about 78
importance of clock synchronization 78
management of 76
returning to Engine 76
See also. License-to-Go
granting licenses and clock synchronization. See note. 70

H
hardware requirements 13
Help menu 53

I
installation
silent 37
using ghosting 38
installing 18
Client software 15, 16
Clients using ghosting 38
Engine software 18
floating licenses 29
KESIReader Firefox extension 109
Kurzweil 3000 on Client computers 35
Network Engine software 21
preparing for 18
remote Administrator 44
Internet Explorer 106
IP address, changing 37

K
keeping the Network Engine on and connected 24
KESIReader Firefox extension installing 109
uninstalling 110
updating 111
Key Disk
see also License Keys
hardware requirements for 12
Kurzweil 1000 34
Kurzweil 3000
Activity Database 5
Kurzweil 3000 Administrator Account 57
Kurzweil 3000 Network and Universal Library 41
Engine machine name 35
overview 4
setup 6
Kurzweil 3000 Network Engine Service about 97
default settings 97
service recovery action 97
service start-up type 97
Kurzweil 3000 Server folder 10
Kurzweil Taskbar 112

L
LAN (local area network) 8, 13
leaving messages 63
License Keys
about 12
hardware requirements for license management using 9
License Management window 29, 81, 82
License Overruns window 82
licenses 12, 33
benefits 8
determining requirements 82
ensuring availability 78
explained 8
installing 29
License Keys 9
number on License Key 80
overrun message 82
returning to License Keys 80
tracking 8
uninstalling 80
usage 82
License-to-Go
about 9
and license management 79
displaying information about 78
Granted
about 69
and Windows Limited Users (see Note) 71
losing due to clock tampering (see Note) 70
returning 76
Remote
activation instructions for users 99
determining system code 102
generating Remote Code 73
generating Return Code 104
returning 77, 104
using 72
returning 76
types of 9
using 69
local area network. See LAN.
locking Engine
unlocking Engine 58
when required 58
locks, broadcasting 65
log file for activity database 88
Log On dialog box 39
logging user statistics 86
logon name option 26
M
managing licenses 31
managing the Network 18
menu system 49
messages
leaving 63
sending 62
Microsoft Access 97 89
Microsoft Jet database 89
Microsoft Management Console 97
Microsoft Speech Platform 12
Installing 34
N
Network (see Kurzweil 3000 Network)
Network Administrator
icon 47
installing additional copies of 44
interface explained 47
launching 47
local versus remote mode 47
menus 49
running in local mode 47
running in remote mode 48
status bar 48
Network Administrator icon 47, 58
Network Browser Utility window 36, 101
Network Neighborhood 35
Network setup 14, 16
NetworkBrowser utility 98
Novell networks 18
O
online registration 53
opening
documents from Universal Library 116
operating systems supported 13

P
preferences 33

R
Read the Web, set up 105
Reading Speed report 89
Refresh button 57
regedit.exe 98
registration, online 53
Registry 98
Remote License-to-Go
See License-to-Go.
remote mode
about 47
excluded functionality with 47
using 48
using Administrator in 47
reports
changing chronological order of
data 90
customized, creating 89
examples 91
generating 89
resizing columns 90
types 89
requirements 13

S
seeing current users 57
Select Report window 90
Send Message command 62
Service Pack 2 24
setting up the Kurzweil 3000 Network
14, 16
sharing
documents through Universal
Library 116
Spell Check Errors report 89
eexample 91
Standalone licenses 31
static IP address 6, 35
determining 19
Student 89
Student Summary reports 89
Syllable Lookup report 89
Synonym Lookup report 89
system administration tasks 47
System Capacity Reached message 82

T
Taskbar, set up 112
TCP/IP 13, 19
Properties sheet 19
toolbar forcing to Clients 64
Tools menu 51
tracking student activity 47, 85

U
understanding the Kurzweil 3000
Network 3
uninstalling
floating licenses 80
KESIRender Firefox extension 110
Kurzweil 3000 Version 10 software 83
licenses 31
Version 10 Client software 83
Version 10 Engine software 84
uninstalling old versions of Kurzweil 3000 21
Universal Library
  accessing shared documents 43, 116
  configuring 41
  configuring access to 115
  configuring access to folder 41
  creating the folder 114
  saving
    documents for sharing 116
  setting up access to 115
  using 116
Universal Library, set up 114
updating
  database 58, 88
  Firefox 111
user
  accounts, maximum number of 59
  files 67, 68
  personal settings 68
  settings 33
users
  adding from a master file 60
  adding from Client 61
  disconnecting 58
  folders on the Network Engine
    computer 68
Users menu 49

V
version information 54
VoiceText
  uninstalling previous versions 34